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ENTER THE PARTICIPANT PRIZE DRAWINGS 
 

To show our appreciation to you, we are giving away a technology product  
each month, and a new Windows 7 computer system at year-end 

 
 

Prize Code for this Course: MEXDAI 
 
Here at ASA Research, we’ve given away thousands of door prizes to participants attending our 
CPE courses, consisting of thousands of copies of Microsoft Office and Peachtree Software, 
more than seventy-five 21-speed bicycles, hundreds of optical mice, headsets, web cameras, 
keyboards, computer speakers, copies of virus protection software, and yes, numerous ceramic 
chickens and other silly stuff. Thousands of attendees have won door prizes and in 2011, we are 
stepping up the giveaway with a new online giveaway program, which provides you with the 
opportunity to keep winning long after the course is over. This is our way of saying thank you to 
our wonderful, loyal attendees. 
  
 

    
To enter, visit www.CarltonCollins.com and click on Prize Drawings as shown below: 

 
  

http://www.carltoncollins.com/
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Example Prizes 

   

Official Rules & Fine Print 
 

1. Entries are cumulative and do not expire. Each time you enter, your name remains entered. For example, 
a person who obtains 3 prize codes and enters three times, will have three chances to win each month, 
every month thereafter. 

2. You may enter once for each prize code you receive. multiple times using the unique prize codes printed 
in each of Mr. Collins' CPE courses you attend, and provided for each online CPE course you take. 

3. You must enter a prize code to enter. Prize codes can be obtained by attending a CPE course taught by 
Mr. Collins, or by taking Mr. Collins' online CPE courses. Bonus prize codes are also awarded occasionally 
throughout the year to those CPAs who are friends of CPE for CPAs Facebook page and CPAs who follow 
us on Twitter.  

4. A prize will be awarded each month to at least one person, selected at random from among the 
cumulative entries. An e-mail will be sent to the winner(s) requesting a mailing address for prize delivery.   

5. Prizes will continue to be awarded each month until this prize giveaway is terminated. Monthly prizes 
generally consist of less expensive technology items such as headsets, optical mice, GPS devices, 
camcorders, cordless keyboards, digital cameras, USB thumb drives, SD flash cards, computer monitors, 
wireless routers, etc. and will also include an annual grand prize of a new Windows 7 computer system. 

6. ASA Research reserves the right to change these rules at any time, without notice. ASA Research reserves 
the right to terminate this prize giveaway at any time, without notice.  
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Additional Materials & Example Files on the Web at www.CarltonCollins.com: 

 
The actual material covered will vary depending upon the knowledge level of the audience, 
questions from the audience, and based on Carlton’s polling the audience for areas of interest. 
Accordingly, much of the following web-based material is eligible and may be covered in this 
course, depending upon these factors.  

 
Chapters, Sessions & Additional Topics Example Files 

New Features in Excel 2010 
61 New Functions in 2010 
New Features in 2007 
Missing Features in 2007 
Excel Data Commands 
Copy Shop Case Study 
Excel Macros 
Excel Data Analysis 
Excel & the Internet 
Portfolio Case Study 
Advanced Excel Concepts 
Excel & Accounting Systems 

File – Carlton’s Top 75 Functions 
File – Carlton’s IF Function  
File – Carlton’s Data Cleaning 
File – Carlton’s Copy Shop  
File - Carlton's Formula File 
File - Carlton's 50 Quick Tips File 
File - Data Bar Formatting 
File - More Functions File 
File - Data Commands File 
File - Roth IRA Analysis 
File - Gantt Example 

 
 
 

“The secret to a good lecture is to have a good beginning and a good ending  
and have the two as close together as possible.” 

http://www.carltoncollins.com/
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Pre-Requisites  Good Familiarity with Microsoft Excel 
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Introduction to Excel Functions 
 
Excel Functions are preprogrammed formulas that make the task of writing complex formulas 
easier. There are a total of 333 functions in Excel. These functions are separated into 11 
categories as follows: 
 

Categories & Number Of Functions In Each Category 
 

1. Database Functions (12) 
2. Date and Time Functions (20) 
3. Engineering Functions (39) 
4. Financial Functions (53) 
5. Information Functions (17) 
6. Logical Functions (6) 
7. Lookup and Reference Functions (18) 
8. Math and Trigonometry Functions (59) 
9. Statistical Functions (80) 
10. Text Functions (27) 
11. External Functions (2) 

 
Relevance to CPAs - Some Excel functions are more powerful than others and some are more 
relevant to the CPA than others. For example, most CPAs will find the IF, SUM, COUNT, 
SUBTOTAL, TEXT, and VLOOKUP are very relevant to the CPA while other engineering and 
trigonometry functions such as LOG, PI, RADIENS, DELTA, TAN, COMPLEX, and HAX2DEC are 
typically less relevant to CPAs.  It has been my experience that the following 75 functions are 
most relevant to the CPA; therefore in my opinion, CPAs wishing to increase their command of 
Excel functions should concentrate on these functions first.  
 

Carlton’s List of The Top 75 Functions Most Relevant to CPAs 
(Sorted By Carlton’s Opinion of Usefulness) 

Open an Excel file Containing Function Examples: 
http://www.ASAResearch.com/web/functions.xlsx    

 
1. IF - Specifies a logical test to perform 

2. SUM - Adds its arguments 

3. SUBTOTAL - Returns a subtotal in a list or database 

4. SUMIF - Adds the cells specified by a given criteria 

5. COUNT - Counts how many numbers are in the list of arguments 

6. COUNTA - Counts how many values are in the list of arguments 

7. AVERAGE - Returns the average of a range of numbers 

8. COUNTBLANK - Counts the number of blank cells within a range 

9. COUNTIF - Counts the number of nonblank cells within a range that meet the given criteria 

10. VALUE - Converts text to a number 

11. TEXT - Formats a number and converts it to text 

http://www.asaresearch.com/web/functions.xlsx
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12. VLOOKUP - Looks in the first column of an array and moves across the row to return the value of 
a cell 

13. HLOOKUP - Looks in the top row of an array and returns the value of the indicated cell 

14. TWO WAY LOOKUP – Using both VLOOKUP and HLOOKUP together 

15. LOOKUP - Looks up values in a vector or array 

16. MATCH - Looks up values in a reference or array 

17. TRIM - Removes spaces from text 

18. PROPER - Capitalizes the first letter in each word of a text value 

19. LOWER - Converts text to lowercase 

20. UPPER - Converts text to uppercase 

21. LEFT - Returns the leftmost characters from a text value 

22. RIGHT - Returns the rightmost characters from a text value 

23. MID - Returns a specific number of characters from a text string starting at the position you 
specify 

24. FIND - Finds one text value within another (case-sensitive) 

25. SUBSTITUTE - Substitutes new text for old text in a text string 

26. LEN - Returns the number of characters in a text string 

27. REPLACE - Replaces text in a string with alternative text 

28. CONCATENATE - Joins several text items into one text item 

29. CLEAN - Removes all nonprintable characters from text 

30. NOW - Returns the serial number of the current date and time 

31. TODAY - Returns the serial number of today's date 

32. DATE - Returns the serial number of a particular date 

33. MONTH - Converts a serial number to a month 

34. DAY - Converts a serial number to a day of the month 

35. YEAR - Converts a serial number to a year 

36. WEEKDAY - Converts a serial number to a day of the week 

37. ROUND - Rounds a number to a specified number of digits 

38. ROUNDDOWN - Rounds a number down, toward zero 

39. ROUNDUP - Rounds a number up, away from zero 

40. MAX - Returns the maximum value in a list of arguments 

41. DMAX - Returns the maximum value from a table array based on a list of arguments 

42. MIN - Returns the minimum value in a list of arguments 

43. DMIN - Returns the minimum value from a table array based on a list of arguments 

44. MEDIAN - Returns the median of the given numbers 

45. MODE - Returns the most common value in a data set 

46. PERCENTILE - Returns the k-th percentile of values in a range 

47. PERCENTRANK - Returns the percentage rank of a value in a data set 

48. PMT - Returns the periodic payment for an annuity 

49. NPV - Returns the net present value of an investment based on a series of periodic cash flows 
and a discount rate 

50. DSUM - Adds the numbers in the field column of records in the database that match the criteria 

51. DCOUNT - Counts the cells that contain numbers in a database 

52. DCOUNTA - Counts nonblank cells in a database 

53. AND - Returns TRUE if all of its arguments are TRUE 
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54. OR - Returns TRUE if any argument is TRUE 

55. CHOOSE - Chooses a value from a list of values 

56. TIME - Returns the serial number of a particular time 

57. FV - Returns the future value of an investment 

58. IRR - Returns the internal rate of return for a series of cash flows 

59. YIELD - Returns the yield on a security that pays periodic interest 

60. CELL - Returns information about the formatting, location, or contents of a cell 

61. INFO - Returns information about the current operating environment 

62. ERROR.TYPE - Returns a number corresponding to an error type 

63. ISBLANK - Returns TRUE if the value is blank 

64. ISNA - Returns TRUE if the value is the #N/A error value 

65. GETPIVOTDATA - Returns data stored in a PivotTable 

66. HYPERLINK - Creates a shortcut or jump that opens a document stored on a network server, an 
intranet, or the Internet 

67. TRANSPOSE - Returns the transpose of an array 

68. ABS - Returns the absolute value of a number 

69. RAND - Returns a random number between 0 and 1 

70. RANDBETWEEN - Returns a random number between the numbers you specify 

71. REPT - Repeats text a given number of times 

72. SLN - Returns the straight-line depreciation of an asset for one period 

73. SYD - Returns the sum-of-years' digits depreciation of an asset for a specified period 

74. DDB - Returns the double declining balance depreciation of an asset for a specified period 

75. DGET - Extracts from a database a single record that matches the specified criteria 

 
'J. Carlton Collins, CPA - Copyright, January 2007, carlton@asaresearch.com 

All 333 Excel Functions 
Organized By Category, Including A Description Of Each Function 

 

 Database Functions 

 Function Description 

1 DAVERAGE Returns the average of selected database entries 

2 DCOUNT Counts the cells that contain numbers in a database 

3 DCOUNTA Counts nonblank cells in a database 

4 DGET Extracts from a database a single record that matches the specified criteria 

5 DMAX Returns the maximum value from selected database entries 

6 DMIN Returns the minimum value from selected database entries 

7 DPRODUCT Multiplies the values in a particular field of records that match the criteria in 
a database 

8 DSTDEV Estimates the standard deviation based on a sample of selected database 
entries 

9 DSTDEVP Calculates the standard deviation based on the entire population of selected 
database entries 

10 DSUM Adds the numbers in the field column of records in the database that match 
the criteria 
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11 DVAR Estimates variance based on a sample from selected database entries 

12 DVARP Calculates variance based on the entire population of selected database 
entries 

   

 Date and Time Functions 

 Function Description 

13 DATE Returns the serial number of a particular date 

14 DATEVALUE Converts a date in the form of text to a serial number 

15 DAY Converts a serial number to a day of the month 

16 DAYS360 Calculates the number of days between two dates based on a 360-day year 

17 EDATE Returns the serial number of the date that is the indicated number of months 
before or after the start date 

18 EOMONTH Returns the serial number of the last day of the month before or after a 
specified number of months 

19 HOUR Converts a serial number to an hour 

20 MINUTE Converts a serial number to a minute 

21 MONTH Converts a serial number to a month 

22 NETWORKDAYS Returns the number of whole workdays between two dates 

23 NOW Returns the serial number of the current date and time 

24 SECOND Converts a serial number to a second 

25 TIME Returns the serial number of a particular time 

26 TIMEVALUE Converts a time in the form of text to a serial number 

27 TODAY Returns the serial number of today's date 

28 WEEKDAY Converts a serial number to a day of the week 

29 WEEKNUM Converts a serial number to a number representing where the week falls 
numerically with a year 

30 WORKDAY Returns the serial number of the date before or after a specified number of 
workdays 

31 YEAR Converts a serial number to a year 

32 YEARFRAC Returns the year fraction representing the number of whole days between 
start_date and end_date 

   

 Engineering Functions 

 Function Description 

33 BESSELI Returns the modified Bessel Function In(x) 

34 BESSELJ Returns the Bessel Function Jn(x) 

35 BESSELK Returns the modified Bessel Function Kn(x) 

36 BESSELY Returns the Bessel Function Yn(x) 

37 BIN2DEC Converts a binary number to decimal 

38 BIN2HEX Converts a binary number to hexadecimal 

39 BIN2OCT Converts a binary number to octal 
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40 COMPLEX Converts real and imaginary coefficients into a complex number 

41 CONVERT Converts a number from one measurement system to another 

42 DEC2BIN Converts a decimal number to binary 

43 DEC2HEX Converts a decimal number to hexadecimal 

44 DEC2OCT Converts a decimal number to octal 

45 DELTA Tests whether two values are equal 

46 ERF Returns the error Function 

47 ERFC Returns the complementary error Function 

48 GESTEP Tests whether a number is greater than a threshold value 

49 HEX2BIN Converts a hexadecimal number to binary 

50 HEX2DEC Converts a hexadecimal number to decimal 

51 HEX2OCT Converts a hexadecimal number to octal 

52 IMABS Returns the absolute value (modulus) of a complex number 

53 IMAGINARY Returns the imaginary coefficient of a complex number 

54 IMARGUMENT Returns the argument theta, an angle expressed in radians 

55 IMCONJUGATE Returns the complex conjugate of a complex number 

56 IMCOS Returns the cosine of a complex number 

57 IMDIV Returns the quotient of two complex numbers 

58 IMEXP Returns the exponential of a complex number 

59 IMLN Returns the natural logarithm of a complex number 

60 IMLOG10 Returns the base-10 logarithm of a complex number 

61 IMLOG2 Returns the base-2 logarithm of a complex number 

62 IMPOWER Returns a complex number raised to an integer power 

63 IMPRODUCT Returns the product of from 2 to 29 complex numbers 

64 IMREAL Returns the real coefficient of a complex number 

65 IMSIN Returns the sine of a complex number 

66 IMSQRT Returns the square root of a complex number 

67 IMSUB Returns the difference between two complex numbers 

68 IMSUM Returns the sum of complex numbers 

69 OCT2BIN Converts an octal number to binary 

70 OCT2DEC Converts an octal number to decimal 

71 OCT2HEX Converts an octal number to hexadecimal 

   

 Financial Functions 

 Function Description 

72 ACCRINT Returns the accrued interest for a security that pays periodic interest 

73 ACCRINTM Returns the accrued interest for a security that pays interest at maturity 

74 AMORDEGRC Returns the depreciation for each accounting period by using a depreciation 
coefficient 

75 AMORLINC Returns the depreciation for each accounting period 
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76 COUPDAYBS Returns the number of days from the beginning of the coupon period to the 
settlement date 

77 COUPDAYS Returns the number of days in the coupon period that contains the 
settlement date 

78 COUPDAYSNC Returns the number of days from the settlement date to the next coupon 
date 

79 COUPNCD Returns the next coupon date after the settlement date 

80 COUPNUM Returns the number of coupons payable between the settlement date and 
maturity date 

81 COUPPCD Returns the previous coupon date before the settlement date 

82 CUMIPMT Returns the cumulative interest paid between two periods 

83 CUMPRINC Returns the cumulative principal paid on a loan between two periods 

84 DB Returns the depreciation of an asset for a specified period by using the fixed-
declining balance method 

85 DDB Returns the depreciation of an asset for a specified period by using the 
double-declining balance method or some other method that you specify 

86 DISC Returns the discount rate for a security 

87 DOLLARDE Converts a dollar price, expressed as a fraction, into a dollar price, expressed 
as a decimal number 

88 DOLLARFR Converts a dollar price, expressed as a decimal number, into a dollar price, 
expressed as a fraction 

89 DURATION Returns the annual duration of a security with periodic interest payments 

90 EFFECT Returns the effective annual interest rate 

91 FV Returns the future value of an investment 

92 FVSCHEDULE Returns the future value of an initial principal after applying a series of 
compound interest rates 

93 INTRATE Returns the interest rate for a fully invested security 

94 IPMT Returns the interest payment for an investment for a given period 

95 IRR Returns the internal rate of return for a series of cash flows 

96 ISPMT Calculates the interest paid during a specific period of an investment 

97 MDURATION Returns the Macauley modified duration for a security with an assumed par 
value of $100 

98 MIRR Returns the internal rate of return where positive and negative cash flows are 
financed at different rates 

99 NOMINAL Returns the annual nominal interest rate 

100 NPER Returns the number of periods for an investment 

101 NPV Returns the net present value of an investment based on a series of periodic 
cash flows and a discount rate 

102 ODDFPRICE Returns the price per $100 face value of a security with an odd first period 

103 ODDFYIELD Returns the yield of a security with an odd first period 

104 ODDLPRICE Returns the price per $100 face value of a security with an odd last period 

105 ODDLYIELD Returns the yield of a security with an odd last period 

106 PMT Returns the periodic payment for an annuity 
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107 PPMT Returns the payment on the principal for an investment for a given period 

108 PRICE Returns the price per $100 face value of a security that pays periodic interest 

109 PRICEDISC Returns the price per $100 face value of a discounted security 

110 PRICEMAT Returns the price per $100 face value of a security that pays interest at 
maturity 

111 PV Returns the present value of an investment 

112 RATE Returns the interest rate per period of an annuity 

113 RECEIVED Returns the amount received at maturity for a fully invested security 

114 SLN Returns the straight-line depreciation of an asset for one period 

115 SYD Returns the sum-of-years' digits depreciation of an asset for a specified 
period 

116 TBILLEQ Returns the bond-equivalent yield for a Treasury bill 

117 TBILLPRICE Returns the price per $100 face value for a Treasury bill 

118 TBILLYIELD Returns the yield for a Treasury bill 

119 VDB Returns the depreciation of an asset for a specified or partial period by using 
a declining balance method 

120 XIRR Returns the internal rate of return for a schedule of cash flows that is not 
necessarily periodic 

121 XNPV Returns the net present value for a schedule of cash flows that is not 
necessarily periodic 

122 YIELD Returns the yield on a security that pays periodic interest 

123 YIELDDISC Returns the annual yield for a discounted security; for example, a Treasury bill 

124 YIELDMAT Returns the annual yield of a security that pays interest at maturity 

   

 Information Functions 

 Function Description 

125 CELL Returns information about the formatting, location, or contents of a cell 

126 ERROR.TYPE Returns a number corresponding to an error type 

127 INFO Returns information about the current operating environment 

128 ISBLANK Returns TRUE if the value is blank 

129 ISERR Returns TRUE if the value is any error value except #N/A 

130 ISERROR Returns TRUE if the value is any error value 

131 ISEVEN Returns TRUE if the number is even 

132 ISLOGICAL Returns TRUE if the value is a logical value 

133 ISNA Returns TRUE if the value is the #N/A error value 

134 ISNONTEXT Returns TRUE if the value is not text 

135 ISNUMBER Returns TRUE if the value is a number 

136 ISODD Returns TRUE if the number is odd 

137 ISREF Returns TRUE if the value is a reference 

138 ISTEXT Returns TRUE if the value is text 

139 N Returns a value converted to a number 



Excel Functions, Macros & Data Commands 

www.CarltonCollins.com Page 14 Copyright April 2011 
 

140 NA Returns the error value #N/A 

141 TYPE Returns a number indicating the data type of a value 

17   

 Logical Functions 

 Function Description 

142 AND Returns TRUE if all of its arguments are TRUE 

143 FALSE Returns the logical value FALSE 

144 IF Specifies a logical test to perform 

145 NOT Reverses the logic of its argument 

146 OR Returns TRUE if any argument is TRUE 

147 TRUE Returns the logical value TRUE 

   

 Lookup and Reference Functions 

 Function Description 

148 ADDRESS Returns a reference as text to a single cell in a worksheet 

149 AREAS Returns the number of areas in a reference 

150 CHOOSE Chooses a value from a list of values 

151 COLUMN Returns the column number of a reference 

152 COLUMNS Returns the number of columns in a reference 

153 GETPIVOTDATA Returns data stored in a PivotTable 

154 HLOOKUP Looks in the top row of an array and returns the value of the indicated cell 

155 HYPERLINK Creates a shortcut or jump that opens a document stored on a network 
server, an intranet, or the Internet 

156 INDEX Uses an index to choose a value from a reference or array 

157 INDIRECT Returns a reference indicated by a text value 

158 LOOKUP Looks up values in a vector or array 

159 MATCH Looks up values in a reference or array 

160 OFFSET Returns a reference offset from a given reference 

161 ROW Returns the row number of a reference 

162 ROWS Returns the number of rows in a reference 

163 RTD Retrieves real-time data from a program that supports COM 
automation (Automation: A way to work with an application's objects from 
another application or development tool. Formerly called OLE Automation, 
Automation is an industry standard and a feature of the Component Object 
Model (COM).) 

164 TRANSPOSE Returns the transpose of an array 

165 VLOOKUP Looks in the first column of an array and moves across the row to return the 
value of a cell 

   

 Math and Trigonometry Functions 

 Function Description 
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166 ABS Returns the absolute value of a number 

167 ACOS Returns the arccosine of a number 

168 ACOSH Returns the inverse hyperbolic cosine of a number 

169 ASIN Returns the arcsine of a number 

170 ASINH Returns the inverse hyperbolic sine of a number 

171 ATAN Returns the arctangent of a number 

172 ATAN2 Returns the arctangent from x- and y-coordinates 

173 ATANH Returns the inverse hyperbolic tangent of a number 

174 CEILING Rounds a number to the nearest integer or to the nearest multiple of 
significance 

175 COMBIN Returns the number of combinations for a given number of objects 

176 COS Returns the cosine of a number 

177 COSH Returns the hyperbolic cosine of a number 

178 DEGREES Converts radians to degrees 

179 EVEN Rounds a number up to the nearest even integer 

180 EXP Returns e raised to the power of a given number 

181 FACT Returns the factorial of a number 

182 FACTDOUBLE Returns the double factorial of a number 

183 FLOOR Rounds a number down, toward zero 

184 GCD Returns the greatest common divisor 

185 INT Rounds a number down to the nearest integer 

186 LCM Returns the least common multiple 

187 LN Returns the natural logarithm of a number 

188 LOG Returns the logarithm of a number to a specified base 

189 LOG10 Returns the base-10 logarithm of a number 

190 MDETERM Returns the matrix determinant of an array 

191 MINVERSE Returns the matrix inverse of an array 

192 MMULT Returns the matrix product of two arrays 

193 MOD Returns the remainder from division 

194 MROUND Returns a number rounded to the desired multiple 

195 MULTINOMIAL Returns the multinomial of a set of numbers 

196 ODD Rounds a number up to the nearest odd integer 

197 PI Returns the value of pi 

198 POWER Returns the result of a number raised to a power 

199 PRODUCT Multiplies its arguments 

200 QUOTIENT Returns the integer portion of a division 

201 RADIANS Converts degrees to radians 

202 RAND Returns a random number between 0 and 1 

203 RANDBETWEEN Returns a random number between the numbers you specify 

204 ROMAN Converts an arabic numeral to roman, as text 
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205 ROUND Rounds a number to a specified number of digits 

206 ROUNDDOWN Rounds a number down, toward zero 

207 ROUNDUP Rounds a number up, away from zero 

208 SERIESSUM Returns the sum of a power series based on the formula 

209 SIGN Returns the sign of a number 

210 SIN Returns the sine of the given angle 

211 SINH Returns the hyperbolic sine of a number 

212 SQRT Returns a positive square root 

213 SQRTPI Returns the square root of (number * pi) 

214 SUBTOTAL Returns a subtotal in a list or database 

215 SUM Adds its arguments 

216 SUMIF Adds the cells specified by a given criteria 

217 SUMPRODUCT Returns the sum of the products of corresponding array components 

218 SUMSQ Returns the sum of the squares of the arguments 

219 SUMX2MY2 Returns the sum of the difference of squares of corresponding values in two 
arrays 

220 SUMX2PY2 Returns the sum of the sum of squares of corresponding values in two arrays 

221 SUMXMY2 Returns the sum of squares of differences of corresponding values in two 
arrays 

222 TAN Returns the tangent of a number 

223 TANH Returns the hyperbolic tangent of a number 

224 TRUNC Truncates a number to an integer 

   

 Statistical Functions 

 Function Description 

225 AVEDEV Returns the average of the absolute deviations of data points from their 
mean 

226 AVERAGE Returns the average of its arguments 

227 AVERAGEA Returns the average of its arguments, including numbers, text, and logical 
values 

228 BETADIST Returns the beta cumulative distribution Function 

229 BETAINV Returns the inverse of the cumulative distribution Function for a specified 
beta distribution 

230 BINOMDIST Returns the individual term binomial distribution probability 

231 CHIDIST Returns the one-tailed probability of the chi-squared distribution 

232 CHIINV Returns the inverse of the one-tailed probability of the chi-squared 
distribution 

233 CHITEST Returns the test for independence 

234 CONFIDENCE Returns the confidence interval for a population mean 

235 CORREL Returns the correlation coefficient between two data sets 

236 COUNT Counts how many numbers are in the list of arguments 
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237 COUNTA Counts how many values are in the list of arguments 

238 COUNTBLANK Counts the number of blank cells within a range 

239 COUNTIF Counts the number of nonblank cells within a range that meet the given 
criteria 

240 COVAR Returns covariance, the average of the products of paired deviations 

241 CRITBINOM Returns the smallest value for which the cumulative binomial distribution is 
less than or equal to a criterion value 

242 DEVSQ Returns the sum of squares of deviations 

243 EXPONDIST Returns the exponential distribution 

244 FDIST Returns the F probability distribution 

245 FINV Returns the inverse of the F probability distribution 

246 FISHER Returns the Fisher transformation 

247 FISHERINV Returns the inverse of the Fisher transformation 

248 FORECAST Returns a value along a linear trend 

249 FREQUENCY Returns a frequency distribution as a vertical array 

250 FTEST Returns the result of an F-test 

251 GAMMADIST Returns the gamma distribution 

252 GAMMAINV Returns the inverse of the gamma cumulative distribution 

253 GAMMALN Returns the natural logarithm of the gamma Function, Γ(x) 

254 GEOMEAN Returns the geometric mean 

255 GROWTH Returns values along an exponential trend 

256 HARMEAN Returns the harmonic mean 

257 HYPGEOMDIST Returns the hypergeometric distribution 

258 INTERCEPT Returns the intercept of the linear regression line 

259 KURT Returns the kurtosis of a data set 

260 LARGE Returns the k-th largest value in a data set 

261 LINEST Returns the parameters of a linear trend 

262 LOGEST Returns the parameters of an exponential trend 

263 LOGINV Returns the inverse of the lognormal distribution 

264 LOGNORMDIST Returns the cumulative lognormal distribution 

265 MAX Returns the maximum value in a list of arguments 

266 MAXA Returns the maximum value in a list of arguments, including numbers, text, 
and logical values 

267 MEDIAN Returns the median of the given numbers 

268 MIN Returns the minimum value in a list of arguments 

269 MINA Returns the smallest value in a list of arguments, including numbers, text, and 
logical values 

270 MODE Returns the most common value in a data set 

271 NEGBINOMDIST Returns the negative binomial distribution 

272 NORMDIST Returns the normal cumulative distribution 

273 NORMINV Returns the inverse of the normal cumulative distribution 
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274 NORMSDIST Returns the standard normal cumulative distribution 

275 NORMSINV Returns the inverse of the standard normal cumulative distribution 

276 PEARSON Returns the Pearson product moment correlation coefficient 

277 PERCENTILE Returns the k-th percentile of values in a range 

278 PERCENTRANK Returns the percentage rank of a value in a data set 

279 PERMUT Returns the number of permutations for a given number of objects 

280 POISSON Returns the Poisson distribution 

281 PROB Returns the probability that values in a range are between two limits 

282 QUARTILE Returns the quartile of a data set 

283 RANK Returns the rank of a number in a list of numbers 

284 RSQ Returns the square of the Pearson product moment correlation coefficient 

285 SKEW Returns the skewness of a distribution 

286 SLOPE Returns the slope of the linear regression line 

287 SMALL Returns the k-th smallest value in a data set 

288 STANDARDIZE Returns a normalized value 

289 STDEV Estimates standard deviation based on a sample 

290 STDEVA Estimates standard deviation based on a sample, including numbers, text, and 
logical values 

291 STDEVP Calculates standard deviation based on the entire population 

292 STDEVPA Calculates standard deviation based on the entire population, including 
numbers, text, and logical values 

293 STEYX Returns the standard error of the predicted y-value for each x in the 
regression 

294 TDIST Returns the Student's t-distribution 

295 TINV Returns the inverse of the Student's t-distribution 

296 TREND Returns values along a linear trend 

297 TRIMMEAN Returns the mean of the interior of a data set 

298 TTEST Returns the probability associated with a Student's t-test 

299 VAR Estimates variance based on a sample 

300 VARA Estimates variance based on a sample, including numbers, text, and logical 
values 

301 VARP Calculates variance based on the entire population 

302 VARPA Calculates variance based on the entire population, including numbers, text, 
and logical values 

303 WEIBULL Returns the Weibull distribution 

304 ZTEST Returns the one-tailed probability-value of a z-test 

   

 Text Functions 

 Function Description 

305 ASC Changes full-width (double-byte) English letters or katakana within a 
character string to half-width (single-byte) characters 
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306 BAHTTEXT Converts a number to text, using the ß (baht) currency format 

307 CHAR Returns the character specified by the code number 

308 CLEAN Removes all nonprintable characters from text 

309 CODE Returns a numeric code for the first character in a text string 

310 CONCATENATE Joins several text items into one text item 

311 DOLLAR Converts a number to text, using the $ (dollar) currency format 

312 EXACT Checks to see if two text values are identical 

313 FIND, FINDB Finds one text value within another (case-sensitive) 

314 FIXED Formats a number as text with a fixed number of decimals 

315 JIS Changes half-width (single-byte) English letters or katakana within a character 
string to full-width (double-byte) characters 

316 LEFT, LEFTB Returns the leftmost characters from a text value 

317 LEN, LENB Returns the number of characters in a text string 

318 LOWER Converts text to lowercase 

319 MID, MIDB Returns a specific number of characters from a text string starting at the 
position you specify 

320 PHONETIC Extracts the phonetic (furigana) characters from a text string 

321 PROPER Capitalizes the first letter in each word of a text value 

322 REPLACE, 
REPLACEB 

Replaces characters within text 

323 REPT Repeats text a given number of times 

324 RIGHT, RIGHTB Returns the rightmost characters from a text value 

325 SEARCH, 
SEARCHB 

Finds one text value within another (not case-sensitive) 

326 SUBSTITUTE Substitutes new text for old text in a text string 

327 T Converts its arguments to text 

328 TEXT Formats a number and converts it to text 

329 TRIM Removes spaces from text 

330 UPPER Converts text to uppercase 

331 VALUE Converts a text argument to a number 

   

 External Functions 

 Function Description 

332 EUROCONVERT Converts a number to euros, converts a number from euros to a euro 
member currency, or converts a number from one euro member currency to 
another by using the euro as an intermediary (triangulation) 

333 SQL.REQUEST Connects with an external data source and runs a query from a worksheet, 
then returns the result as an array without the need for macro programming 
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Chapter 2  

The =IF Function 
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=IF  
 
The “IF” function is the most powerful of all functions – not just in Excel, but in any 
programming language. Commonly referred to as “Conditional Programming”, it is the IF 
function that enables us to introduce logical thinking into any program. This function is also 
referred to as the “If-Then-Else” command, “conditional expressions”, or “Propositional Logic”. 
The following Wikis explains this concept in more detail: 
 

http://en.wikipedia.org/wiki/Conditional_(programming). 
http://en.wikipedia.org/wiki/Logical_conditional#Conditional_statements 

 
The clever CPA can use the IF Function to build elaborate Excel templates and financial models 
containing an almost unlimited amount of sophisticated programming. Presented below are 
several examples to help you better understand the application of this powerful tool. 
 
Simple IF - The IF function returns one value if a condition you specify evaluates to TRUE, and 
another value if that condition evaluates to FALSE. Presented below is a simple example: 
 

 
 
 
Simple IF with Calculation – Presented below is an example that is a little more complex: 
 

 
 
Simple IF – Larger Example - Presented below is yet another IF example on a little larger scale – 
this example shows how one might apply the IF function to evaluate budget versus actual 
comparisons.  
 

http://en.wikipedia.org/wiki/Conditional_(programming)
http://en.wikipedia.org/wiki/Logical_conditional#Conditional_statements
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Simple IF with Drop Down - In the following example, the IF function is checking to see if they 
have signed up for insurance.  If they have, the deduction amount is entered.    
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Simple IF with Calculation - The next IF function example is determining each employees 
earned vacation days.  If they have worked for more than a year, they have earned 5 vacation 
days plus one day for each additional full year.   
  

 
    
 
Nested IF Functions - In this sample, there are four possibilities for bonuses. 
 

 
 
 
IF Function with Logical OR Argument - Teams A and C meet on Tuesday, Teams B and D meet 
on Thursday.  We want to list the meeting days in column D.    
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More Complex IF Function Example - The following IF example shows a more complex 
application in which the user selects a taxpayer status from a drop down list, which then 
retrieves the correct tax base, threshold, and incremental tax rates to be used in calculating tax. 
 
This example illustrates how a CPA might prepare an income statement template that 
calculates the appropriate amount of taxes as net income and the taxpayer status changes. 
Essentially the template calculates the correct tax given all four possible taxpayer statuses, and 
the IF statements are used to select the correct answers based on the taxpayer status selected. 
 

 
 
Keep in mind that despite the many accolades mentioned above, the IF Function is not always 
the best solution. For example, the VLOOKUP would be a better and easier function to use to 
extract data from a list as shown in the nested IF Function a few examples above. Many Excel 
Functions also provide built-in “IF-Then-Else” functionality.    
 
Key Pointers for Using the IF Function: 
 

1. Nesting – You can embed up to 8 nested IF functions in a single formula in Excel 2003, and up to 
64 IF nested functions in Excel 2007.  

2. AND, OR  – You can use the AND and/or OR operator to add more conditions to an IF Function.  
3. Variations of IF - Excel offers several variations of the IF function as follows: COUNTIF, 

COUNTIFS, SUMIF, SUMIFS. 
4. Evaluating an IF Error – Since the IF statement provides only a true or false result, there is no 

way to evaluate an IF Function to ERROR. If you receive an error, you wrote the formula wrong.  
5. The Null Set - The Double Quotes is the Null Set, or absence of a value. For example, when 

testing for a Zero balance or testing for a blank cell, the following IF functions would apply: 
a. =IF(A1=0,”ZERO”,””) 
b. =IF(A1=””,”Blank”,””) 

(Excel also provides an ISBLANK Function that would also work.) 
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Chapter 3 

Using Functions To 
Crunch & Clean Data  
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Cleaning Data Using Functions  
 
CPAs often receive or retrieve data from many sources in a wide variety of formats such as Text 
or CSV formats. You don't always have control over the format and type of data that you import 
from an external data source, such as a database, text file, or a Web page. Before you can 
analyze the data, you often need to clean it up. Fortunately, Office Excel has many features to 
help you get data in the precise format that you want. Sometimes, the task is straightforward 
and there is a specific feature that does the job for you.  
 
For example, you can easily use Spell Checker to clean up misspelled words in columns that 
contain comments or descriptions. Or, if you want to remove duplicate rows, you can quickly do 
this by using the Remove Duplicates dialog box. At other times, you may need to manipulate 
one or more columns by using a formula to convert the imported values into new values.  
 
For example, if you want to remove trailing spaces, you can create a new column to clean the 
data by using a formula, filling down the new column, converting that new column's formulas 
to values, and then removing the original column. Excel provides many functions to help you 
clean your data as follows: 
 

1. Import 
2. Text to Columns 
3. Remove Duplicates  
4. Find & Replace  
5. Spell Check 
6. =UPPER 
7. =LOWER 
8. =PROPER 
9. =FIND  

10. =SEARCH  
11. =LEN 
12. =SUBSTITUTE 
13. =REPLACE 
14. =LEFT 
15. =MID 
16. =RIGHT 
17. =VALUE 
18. =CONCATENATE 

19. =TEXT 
20. =TRIM 
21. =CLEAN 
22. =FIXED 
23. =DOLLAR 
24. =CODE 
25. Macros 

 

 
If you dry your razor after each use, it will stay sharp for an entire year. 



1. Importing Data into Excel – Of course excel opens up excel files, but what happens when 
you attempt to open data that is not contained in an Excel format? The answer is that Excel 
automatically imports that data on the fly and displays a Import Wizard to help you 
complete the process. The Text Import Wizard examines the text file that you are importing 
and helps you import the data the way that you want. To start the Text Import Wizard, on 
the Data tab, in the Get External Data group, click From Text. Then, in the Import Text File 
dialog box, double-click the text file that you want to import. The following dialog box will 
be displayed: 
 

 
 
If items in the text file are separated by tabs, colons, semicolons, spaces, or other 
characters, select Delimited. If all of the items in each column are the same length, select 
Fixed width. In step 3, click the Advanced button to specify that one or more numeric values 
may contain a trailing minus sign. Also click the desired data format for each column to be 
imported.  
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2. Text to Columns – The Text to Columns command located on the Data Ribbon works exactly 
the same way as described above – the user simply launches it to convert data within an 
existing worksheet.  

 
3. Removing Duplicate Rows - Duplicate rows are a common problem when you import data. 

You can identify and remove duplicate rows by using the Data, Advanced Filter, Unique 
Records Only tool as show in the screen below.  

 

 
 

4. Find and Replace Text – This tool can be used to identify and remove leading string, such as 
a label followed by a colon and space, or a suffix, such as a parenthetic phrase at the end of 
the string that is obsolete or unnecessary. You can do this by finding instances of that text 
and then replacing it with no text or other text. 
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Noteworthy Find and Replace Points: 
 

1. You can search and replace for an entire worksheet, or the entire workbook. 
2. You can find and replace formats with new formats. 
3. There is a cell chooser option that makes it easier to find and replace formats. 
4. If you highlight a range of cells, then search and replace only searches and replaces 

within that range of cells.  
5. You can replace all at once or one at a time. 
6. You could also find and replace references in a formula. 

 
5. Spell Check - You can use a spell checker to not only find misspelled words, but to find values that 

are not used consistently, such as product or company names, by adding those values to a custom 
dictionary. The spell check function also checks your grammar as well.  

 

 
 
Changing The Case Of Text – You can use one or more of the three Case functions to 
convert text to lowercase letters, such as e-mail addresses, uppercase letters, such as 
product codes, or proper case, such as names or book titles. 
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6. = UPPER - Converts text to uppercase letters.  

 

 
 

7. =LOWER - Converts all uppercase letters in a text string to lowercase letters.  

 

 
 

8. =PROPER - Capitalizes the first letter in a text string and any other letters in text that follow any 
character other than a letter. Converts all other letters to lowercase letters.  

 

 
 

Merging And Splitting Columns - A common task after importing data from an external data 
source is to either merge two or more columns into one, or split one column into two or 
more columns. For example, you may want to split a column that contains a full name into a 
first and last name. Or, you may want to split a column that contains an address field into 
separate street, city, region, and postal code columns. The reverse may also be true. 
Presented below are functions that to help you accomplish these tasks: 
 

9. =FIND – Use Returns the starting position of a character, string of characters or word with a cell. 
Find is case sensitive. 
 

 
 

10. =SEARCH – Returns the starting position of a character, string of characters or word with a cell. 
Search is not case sensitive. 

 

 
 

11. =LEN – Displays the length or number of characters in a cell.  

 

http://office.microsoft.com/search/redir.aspx?AssetID=HP100625821033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=HP100625701033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=HP100625731033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
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12. =SUBSTITUTE – Replaces a character or characters with a character or characters that you specify. 

 
 

13. =REPLACE - Replaces a character or characters with a character or characters that you specify. 
 

 
 

14. =LEFT – Extracts the specified number of characters from a cell, starting from the left.  
 

 
 

15. =MID – Extracts the specified number of characters from a cell, starting from somewhere in the 
middle of the cell. 
 

 
 

16. =RIGHT – Extracts the specified number of characters from a cell, starting from the right. 
 

 
 

17. =Value – Converts text to values so the data can be added, subtracted, multiplied, divided or 
referenced in a function. 
 

 
 

18. =CONCATENATE - Joins two or more text strings into one text string.  

 

http://office.microsoft.com/search/redir.aspx?AssetID=HP100625781033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=HP100625741033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
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Variations of these functions that are used when working with foreign languages:  
 
=FINDB – Use this when working with foreign characters like these ( "," ) 
=SEARCHB – Use this when working with foreign characters like these ( "," )  
=REPLACEB – Use this when working with foreign characters like these ( "," ) 
=LEFTB – Use this when working with foreign characters like these ( "," ) 
=RIGHTB – Use this when working with foreign characters like these ( "," ) 
=LENB – Use this when working with foreign characters like these ( "," ) 
=MIDB – Use this when working with foreign characters like these ( "," ) 

 
Cleaning Text – (Removing Spaces And Nonprinting Characters From Text) - Sometimes 
text values contain leading, trailing, or multiple embedded space characters (Unicode 
character set values 32 and 160), or nonprinting characters (Unicode character set values 0 
to 31, 127, 129, 141, 143, 144, and 157). These characters can sometimes cause unexpected 
results when you sort, filter, or search. For example, in the external data source, users may 
make typographical errors by inadvertently adding extra space characters, or imported text 
data from external sources may contain nonprinting characters that are embedded in the 
text. Because these characters are not easily noticed, the unexpected results may be 
difficult to understand. Following is a list of functions you can use to remove these 
unwanted characters: 
 

19. =TEXT - Converts a value to text in a specific number format. 
 

 
 

20. =TRIM - Removes the 7-bit ASCII space character (value 32) from text.  
 

 
 

21. =CLEAN - Removes the first 32 nonprinting characters in the 7-bit ASCII code (values 0 
through 31) from text. 

http://office.microsoft.com/search/redir.aspx?AssetID=HP100625771033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=HP100625741033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=HP100625681033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=HP100625761033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=HP100625691033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=HP100625711033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
javascript:AppendPopup(this,'ofUnicode_1_1')
http://office.microsoft.com/search/redir.aspx?AssetID=HP100625801033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=HP100625811033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=HP100625601033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
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22. =FIXED - Rounds a number to the specified number of decimals, formats the number in 

decimal format by using a period and commas, and returns the result.  
 

 
 

23. =DOLLAR - Converts a number to text format and applies a currency symbol.  
 

 
 

24. =CODE - Returns a numeric code for the first character in a text string.  
 
Fixing Dates and Times - There are many different date formats, and these varied formats 
may be confused with numbered part codes or other strings that contain slash marks or 
hyphens, dates and times often need to be converted and reformatted. Presented below is 
a list of functions that help you accomplish this task. 
 

25. =DATE - Returns the sequential serial number that represents a particular date. If the cell format 
was General before the function was entered, the result is formatted as a date. 
 

 
 

26. =DATEVALUE - Converts a date represented by text to a serial number.  
 

http://office.microsoft.com/search/redir.aspx?AssetID=HP100625651033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=HP100625631033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=HP100625611033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=HP100622831033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=HP100622841033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
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27. =TIME - Returns the decimal number for a particular time. If the cell format was General 
before the function was entered, the result is formatted as a date.  
 

28. =TIMEVALUE - Returns the decimal number of the time represented by a text string. The 
decimal number is a value ranging from 0 (zero) to 0.99999999, representing the times 
from 0:00:00 (12:00:00 AM) to 23:59:59 (11:59:59 P.M.).  
 
Transforming And Rearranging Columns And Rows - Most of the analysis and formatting 
features in Office Excel assume that the data exists in a single, flat two-dimensional table. 
Sometimes you may want to make the rows become columns, and the columns become 
rows. At other times, data is not even structured in a tabular format, and you need a way to 
transform the data from a nontabular to a tabular format. The following function can help 
you achieve this goal: 
 

29. =TRANSPOSE - Returns a vertical range of cells as a horizontal range, or vice versa. 
 

 
 

30. Data Fill In Trick – A clever trick for filling in missing data can be accomplished using the GOTO, 
Special, Blanks command. Here is how it works. This trick works well when you have a large volume 
of data but descriptions are not provided for every row, as shown in the example below: 

 

http://office.microsoft.com/search/redir.aspx?AssetID=HP100622951033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=HP100622961033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=HP100698341033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
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Start by entering a simple formula referencing the data label in the above cell, just like this: 
 

 
 

a. Next copy that formula... 
b. Highlight the entire range containing data labels in columns A and B. columns... 
c. Press the F5 key to launch the GoTo dialog box... 
d. Select the Options Box... 
e. Click on the “Blanks” radio button... 
f. Press Enter... 
g. Paste. 
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This action will cause all data labels to repeat in the empty cells beneath. Next: 
 

h. Copy columns A & B... 
i. Paste Special as values to convert the formulas to text based data labels... 
j. You are now ready to sort, filter, subtotal and pivot your data. 

 
Fetching Data - Occasionally, database administrators use Office Excel to find and correct 
matching errors when two or more tables are joined. This might involve reconciling two 
tables from different worksheets, for example, to see all records in both tables or to 
compare tables and find rows that don't match. 
 

31. =VLOOKUP - Searches for a value in the first column of a table array and returns a value in 
the same row from another column in the table array. For example, consider the example 
below which uses a =VLOOKUP function to calculate the appropriate amount  of tax due 
based on the IRS rate schedule.  
 
 
 
 
 
 
 
 
 

If you happen to over-salt a pot of soup, just drop in a peeled potato. The 
potato will absorb the excess salt. 

http://office.microsoft.com/search/redir.aspx?AssetID=HP100698351033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
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As the Income statement shown in the shaded area is updated , the resulting taxable 
income amount is referenced in Cell F13. Next, 3 VLOOKUP functions pull the appropriate 
rate, base and threshold information from the rate schedule to be used in calculating 
income tax. Once calculated, the resulting tax is referenced back to the income statement 
for the purposes of computing Net income After taxes. 
 
Key points to Consider when Using VLOOKUP: 
 

a. If you are looking up based on text, the first column containing lookup 
values must be sorted alphabetically in descending order – else it will not 
work properly.  
 

b. If you are looking up based on text, you must have an exact match between 
the lookup value and the table array value. 

 
c. If you are looking up based on values, the first column containing lookup 

values must be sorted numerically in descending order – else it will not work 
properly.  
 

d. If you are looking up based on values, then Excel will choose the closest 
value without going over. For example, if the lookup value is 198,000 and 
the table array contains values of 100,000 and 200,000, the n excel will 
choose 100,000 because 200,000 goes over or exceeds 198,000. (It might be 
helpful to think back to the old Bob barker game show the Price is Right.)  
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32. =HLOOKUP - Searches for a value in the top row of a table or an array of values, and then 
returns a value in the same column from a row you specify in the table or array.  
 

33. =INDEX - Returns a value or the reference to a value from within a table or range. There are 
two forms of the INDEX function: the array form and the reference form.  
 

34. =MATCH - Returns the relative position of an item in an array that matches a specified 
value in a specified order. Use MATCH instead of one of the LOOKUP functions when you 
need the position of an item in a range instead of the item itself.  
 

35. =OFFSET - Returns a reference to a range that is a specified number of rows and columns 
from a cell or range of cells. The reference that is returned can be a single cell or a range of 
cells. You can specify the number of rows and the number of columns to be returned.  
 

36. Data Cleaning with Macros - To periodically clean the same data source, consider recording 
a macro or writing code to automate the entire process. There are also a number of 
external add-ins written by third-party vendors, listed in the Third-party providers section, 
that you can consider using if you don't have the time or resources to automate the process 
on your own. 
 

37. RAND( ), RANDBETWEEN( ), ROUND( ) – In Excel 2003, RANDBETWEEN is not in the 
standard EXCEL installation but if the analysis tool pack is installed and the add-in activated 
it is an extremely useful function. 
 

http://office.microsoft.com/search/redir.aspx?AssetID=HP100624111033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=HP100698311033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=HP100624141033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=HP100624151033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/client/helppreview.aspx?AssetID=HA102218401033&QueryID=HMvF2DuYZ0&respos=10&rt=2&ns=EXCEL&lcid=1033&pid=CH100648471033#Third-party providers


Excel Functions, Macros & Data Commands 

www.CarltonCollins.com Page 39 Copyright April 2011 
 

 
 

38. Informational Functions 
CELL(info_type,reference) - Info_type   is a text value that specifies what type of cell 
information you want. The following list shows the possible values of info_type and the 
corresponding results. 

Info_type Returns 

"address" Reference of the first cell in reference, as text. 

"col" Column number of the cell in reference. 

"color" 1 if the cell is formatted in color for negative values; otherwise returns 0 
(zero). 

"contents" Value of the upper-left cell in reference; not a formula.  

"filename" Filename (including full path) of the file that contains reference, as text. 
Returns empty text ("") if the worksheet that contains reference has not yet 
been saved. 

"format" Text value corresponding to the number format of the cell. The text values 
for the various formats are shown in the following table. Returns "-" at the 
end of the text value if the cell is formatted in color for negative values. 
Returns "()" at the end of the text value if the cell is formatted with 
parentheses for positive or all values. 

"parentheses" 1 if the cell is formatted with parentheses for positive or all values; 
otherwise returns 0. 

"prefix" Text value corresponding to the "label prefix" of the cell. Returns single 
quotation mark (') if the cell contains left-aligned text, double quotation 
mark (") if the cell contains right-aligned text, caret (^) if the cell contains 
centered text, backslash (\) if the cell contains fill-aligned text, and empty 
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text ("") if the cell contains anything else.  

"protect" 0 if the cell is not locked, and 1 if the cell is locked. 

"row" Row number of the cell in reference. 

"type" Text value corresponding to the type of data in the cell. Returns "b" for 
blank if the cell is empty, "l" for label if the cell contains a text constant, and 
"v" for value if the cell contains anything else. 

"width" Column width of the cell rounded off to an integer. Each unit of column 
width is equal to the width of one character in the default font size. 

Reference  the cell that you want information about. If omitted, information specified in 
info_type is returned for the last cell that was changed. The following list describes the text 
values CELL returns when info_type is "format", and reference is a cell formatted with a 
built-in number format. 

If the Microsoft Excel format is CELL returns 

General  "G" 

0 "F0" 

#,##0  ",0" 

0.00 "F2" 

#,##0.00  ",2" 

$#,##0_);($#,##0)  "C0" 

$#,##0_);[Red]($#,##0)  "C0-" 

$#,##0.00_);($#,##0.00) "C2" 

$#,##0.00_);[Red]($#,##0.00)  "C2-" 

0%  "P0" 

0.00%  "P2" 

0.00E+00  "S2" 

# ?/? or # ??/?? "G" 

m/d/yy or m/d/yy h:mm or mm/dd/yy "D4" 

d-mmm-yy or dd-mmm-yy "D1" 

d-mmm or dd-mmm "D2" 
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mmm-yy  "D3" 

mm/dd "D5" 

h:mm AM/PM  "D7" 

h:mm:ss AM/PM  "D6" 

h:mm  "D9" 

h:mm:ss  "D8" 

 
If the info_type argument in the CELL formula is "format", and if the cell is formatted later 
with a custom format, then you must recalculate the worksheet to update the CELL formula. 
 

 
 
Third-Party Solutions – In case Excels built in functions are not sufficient to meet your 
needs, following is a partial list of third-party providers that have products that are used to 
clean data in a variety of ways. 
 

Provider Product 
Add-in Express Ltd. Advanced Find & Replace, Merge Cells Wizard 
Add-Ins.com Duplicate Finder 
AddinTools AddinTools Assist 
CDX Zip Stream 
Click 2 Convert Converts PDF to Excel formats 
DigDB Add-ins for Excel® 
JKP Application Development Flexfind for Excel 
J-Walk & Associates, Inc. Power Utility Pak Version 7 
Office Assistance LLC Similar Data Finder for Excel® 
PATools PATools Advanced Find Replace 
PDF2XL Converts PDF files to Excel Formats 
Spinnaker Software Solutions Spinnaker DB tools for Excel 
Vonnix Excel Power Expander 4.6 
WinPure ListCleaner Lite 
ListCleaner Pro 
Clean and Match 2007 

 

http://office.microsoft.com/search/redir.aspx?AssetID=EM101250071033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=EM012315851033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=XT102259091033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=EM011832581033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://www.cdxtech.com/CDXZipStream_Overview.aspx?m=3
http://office.microsoft.com/search/redir.aspx?AssetID=EM102164121033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=EM011490771033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=XT102259101033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=EM102203601033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=EM101070251033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=EM011232781033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=XT102259111033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=XT102259121033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=XT102259131033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
http://office.microsoft.com/search/redir.aspx?AssetID=XT102259141033&CTT=5&Origin=HA102218401033&app=EXCEL&ver=12
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Chapter 4 

Data Commands 
The Heart & Soul Of Excel  
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The Data Menu - Perhaps the parts of Excel that are of most value to CPAs, but least used 
by CPAs are the Data commands found under the Data menu in Excel 2003 and earlier, and 
on the data Ribbon in Excel 2007. These commands are shown below, and we will 
concentrate the next hour to studying these commands. 

 

 
 

 
 

Data Sort - The Sort tool does exactly what it implies – it sorts and data. Key sorting 

points are as follows: 
 

1. Contiguous Data - The “A to Z” sorting tool can sort large matrix of data 
automatically as long as the data is contiguous. In other words, your data should 
contain no blank columns, no blank rows, and the columns must all be labeled. 
Only then will Excel always correctly select the entire matrix for sorting. 
 

2. A to Z Button - Simply place the cursor in the desired column for sorted, and 
press the A to Z or Z to A button as the case may be. Excel will automatically sort 
all continuous columns that have headings and all contiguous rows from the top 
row under the heading labels down to the last row in the selected column that 
contains data. (Note - If you accidently select 2 cells instead of just one, your 
results will not be correct.) 
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3. Sort by 64 Columns - The “Sort” tool is dramatically enhanced in Excel 2007 as it 
now provides the ability to sort by up to 64 columns, instead of just 3 columns. 
Presented below is a dialog box which shows this expanded functionality.  

 

 
 

4. Sort Left to Right – Excel has always provided the ability to sort left to right. To do 
so, select the options box in the Sort Dialog box and click the check box labeled 
“Sort left to Right” as shown below. 
 

 
 

5. Sort by Color – Excel 2007 now provides the ability to sort by font color or by cell 
color, or both. This is handy in many ways. Sometimes CPAs use color to tag or 
mark certain cells  - and later find it useful to be able to sort by those markings. In 
other situations CPAs use conditional formatting to apply color to cells using a 
wide variety of rules. Thereafter Excel can sort the data based on the resulting 
colors. The sort-by-color options are shown below. 
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To be accurate, it was possible to sort by color in Excel 2003. To accomplish this 
task, you needed to use the =CELL function in order to identify information about 
a given cell such as the cell color or font color. Thereafter, the results of that 
function could be used to sort rows – which effectively means that you can sort 
by color in Excel 2003 – but it takes a bit more effort. 
 

6. Sort By Custom List – Another sorting capability in Excel is the ability to sort by 
Custom List. For example, assume a CPA firm has ten partners, and the Managing 
partner prefers to be shown at the top of the list, and the remaining Partners 
based on seniority. In this case, you could create a Custom List in the excel 
Options dialog box listing the partners in the desired order, and then sort future 
reports based on that order. 
 
Perhaps a better example use of this feature would be to create a non-alphabetic 
custom list of your chart of accounts, and then sort transactions to produce a 
general ledger in chart of account order – even if your preferred chart of accounts 
is not alphabetical. the partner seniority does not match the alphabetic names, 
nor any  

 

Filtering Data - Using AutoFilter to filter data allows you to view a subset of your data 

in a range of cells or table. Once you have filtered the data, you can apply additional filters 
to further refine your data view. When you are done, you can clear a filter to once again 
redisplay all of the data. To use this tool, start with any list of data and turn on the 
AutoFilter tool. Then position your cursor in the column you want to filter and use the drop 
down arrows to apply your filters as shown in the screen below. 
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Once the filters are applied, you will see a subset your data. For example, the screen 
presented below shows filtered data for only Macon and Savannah properties.  

 

 
 
As filters are applied, a small funnel appears in the drop down arrow button to indicate that 
a filter has been applied. You can apply filters for multiple columns simultaneously. 
 
Key Points Concerning The AutoFilter Command: 
 

1. Contiguous Data – The AutoFilter tools works best when you are working with data 
that is contiguous. In other words, your data should contain no blank columns, no 
blank rows, and the columns must all be labeled.  
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2. Filter by Multiple Columns -  You can filter by more than one column. 

 
3. Removing Filters – In Excel 2003 and earlier, a faster way to remove multiple filters is 

to turn off filtering and then turn filtering back on. In Excel 2007 you can simple click 
the Clear button in the Sort and Filter Group as shown below.  
 

 
 

4. Filters are Additive  - Each additional filter is based on the current filter and further 
reduces the subset of data. 
 

5. Three Types of Filters – You can filter based on list values, by formats, or by criteria. 
Each of these filter types is mutually exclusive for each range of cells or column table. 
For example, you can filter by cell color or by a list of numbers, but not by both; you 
can filter by icon or by a custom filter, but not by both.  
 

 
6. Filters Enabled - A drop-down arrow  means that filtering is enabled but not 

applied. 
 

7. Filter Applied - A Filter button  means that a filter is applied. 
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8. Filter Spanning - The commands under 
the All Dates in the Period menu, such 
as January or Quarter 2, filter by the 
period no matter what the year. This 
can be useful, for example, to compare 
sales by a period across several years. 
 

9. This Year vs. Year-to-Date Filtering - 
This Year and Year-to-Date are 
different in the way that future dates 
are handled. This Year can return dates 
in the future for the current year, 
whereas Year to Date only returns 
dates up to and including the current 
date. 
 

10. Filtering Dates - All date filters are 
based on the Gregorian calendar as  
decreed by Pope Gregory XIII, after 
whom the calendar was named, on 24 
February 1582. The Gregorian calendar modifies the Julian calendar's regular four-
year cycle of leap years as follows: Every year that is exactly divisible by four is a leap 
year, except for years that are exactly divisible by 100; the centurial years that are 
exactly divisible by 400 are still leap years. For example, the year 1900 is not a leap 
year; the year 2000 is a leap year. 

 
11. Filtering By Days of Week - If you want to filter by days of the week, simply format 

the cells to show the day of the week. 
 

12. Top & Bottom Filtering - On the Data tab, in 
the Sort & Filter group, click Filter. Point to 
Number Filters and then select Top 10. To 
filter by number, click Items. To filter by 
percentage, click Percent. Note - Top and 
bottom values are based on the original 
range of cells or table column and not the 
filtered subset of data. 
 

13. Above & Below Average Filtering - On the 
Data tab, in the Sort & Filter group, click 
Filter. Point to Filter by Numbers that are 
Above/Below Average. Note – These values 
are based on the original range of cells or 
table column and not the filtered subset of data. 
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14. Filtering Out Blanks - To filter for blanks, in the AutoFilter menu at the top of the list 

of values, clear (Select All), and then at the bottom of the list of values, select 
(Blanks). 
 

15. Filtering By Color - Select Filter by Color, and then depending on the type of format, 
select Filter by Cell Color, Filter by Font Color, or Filter by Cell Icon. 
 

16. Filter by Selection - To filter by text, number, or date or time, click Filter by Selected 
Cell's Value and then: To filter by cell color, click Filter by Selected Cell's Color. To 
filter by font color, click Filter by Selected Cell's Font Color. To filter by icon, click 
Filter by Selected Cell's Icon. 
 

17. Refreshing Filters - To reapply a filter after the data changes, click a cell in the range 
or table, and then on the Data tab, in the Sort & Filter group, click Reapply. 
 

 

Data Form – Excel’s 2003 Data Form tool makes Excel look more and behave more like a 

database, such as Microsoft Access. (The Form button has not been included on the Office 
Fluent user interface Ribbon, but you can still use it in Office Excel 2007 by adding the Form 
button to the Quick Access Toolbar.)  
 

 
 
 
A data form provides a convenient means to enter or display one complete row of 
information in a range or table without scrolling horizontally. You may find that using a data 
form can make data entry easier than moving from column to column when you have more 
columns of data than can be viewed on the screen. Use a data form when a simple form of 
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text boxes that list the column headings as labels is sufficient and you don't need 
sophisticated or custom form features, such as a list box or spin button. 
 
Key Points using data Form: 
 

1. You cannot print a data form. 
  
2. Because a data form is a modal dialog box, you cannot use either the Excel Print 

command or Print button until you close the data form.  
 
3. You might consider using the Windows Print Screen key to make an image of the 

form, and then paste it into Microsoft Word for printing. 
 
 

Data Subtotals – Excel provides an automatic subtotaling which will automatically 

calculate and insert subtotals and grand totals in your list or table. Once inserted, Excel 
recalculates subtotal and grand total values automatically as you enter and edit the detail 
data. The Subtotal command also outlines the list so that you can display and hide the detail 
rows for each subtotal. Examples of a the Subtotal dialog box and a resulting subtotaled 
table are shown below. 

 
 

 
Key points to Consider When Using Subtotaling are as follows: 
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1. Contiguous Data – The Subtotal tools works best when you are working with data 

that is contiguous. In other words, your data should contain no blank columns, no 
blank rows, and the columns must all be labeled.  
 

2. Sort Before Your Subtotal - You must sort the data by the column you wish to 
Subtotal by, else you will receive erroneous results.  

 
3. Other Mathematical Applications - The Subtotal tool not only calculates subtotals, 

but it can also calculate minimums, maximums, averages, standard deviations, and 
other functions.  

 

 
 

4. Subtotals in 2007 Tables – Excel 2007 deploys Subtotaling a little differently in that 
the Subtotal tool appears at the bottom of each column in each table, as shown in 
the screen below. 
 

 
  

5. Automatic Outlining - Subtotaling automatically inserts Outlines, which is really 
cool. You can then condense and expand the data in total and by subtotal. Some 
CPAs also like to copy and paste the condensed subtotal information to another 
location but find that this process copies and pastes all of the data. There are two 
ways to achieve a clean copy and paste without grabbing all the hidden data as 
follows: 
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a. CTRL key – Hold the Control Key down while you individually click on each subtotal 
row. This will enable you to copy and paste just the subtotal data. This approach can 
be problematic because if you mis-click, you have to start over. 

 
b. Select Visible Cells – A better approach is to use the Select Visible Cells tool. This 

tool will select on the data you can see, after which the copy and paste routine will  
yield the desired results. This option is better because it is faster and less error 
prone.  
 

Data Validation  
 

Data Validation can be used to limit the data that can be entered into a cell. For example, 
you might want the user to enter only values between 1% and 99%. You might also use this 
tool to enable data input to a drop down list. This has two advantages in that it can be 
faster and more accurate.  Start with the dialog box below to create your drop down list 
functionality. 
 

 
 
After making all the necessary selections in the validation list dialog box, your worksheet 
will behave as shown below.  
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You can also provide messages to define what input you expect for the cell, and instructions 
to help users correct any errors. For example, in a marketing workbook, you can set up a cell 
to allow only account numbers that are exactly three characters long. When users select the 
cell, you can show them a message such as this one: 
 

 
 
If users ignore this message and type invalid data in the cell, such as a two-digit or five-digit 
number, you can show them an actual error message. In a more advanced scenario, you 
might use data validation to calculate the maximum allowed value in a cell based on a value 
elsewhere in the workbook. In the following example, the user has typed $4,000 in cell E7, 
which exceeds the maximum limit specified for commissions and bonuses. 
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If the payroll budget were to increase or decrease, the allowed maximum in E7 would 
automatically increase or decrease with it. 
 

PivotTables   
 
The PivotTable report tool provides an interactive way to summarize large amounts of data. 
Use should use the PivotTable tools to crunch and analyze numerical data PivotTable 
reports are particularly useful in the following situations: 

 
a. Rearranging rows to columns or columns to rows (or "pivoting") to see different 

summaries of the source data.  
b. Filtering, sorting, grouping, and conditionally formatting your data. 
c. Preparing concise, attractive, and annotated online or printed reports  
d. Querying large amounts of data. 
e. Subtotaling and aggregating numeric data. 
f. Summarizing data by categories and subcategories 
g. Creating custom calculations and formulas. 
h. Expanding and collapsing levels of data. 
i. Drilling down to details from the summary data  
 

In essence, PivotTables present multidimensional data views to the user – this process is 
often referred to as “modeling”, “data-cube analysis”, or “OLAP data cubes”.  To re-arrange 
the PivotTable data, just drag and drop column and row headings to move data around.  
PivotTables are a great data analysis tool for management.   
 
If you have never used a PivotTable before, initially the concept can be difficult to grasp. 
The best way to understand a PivotTable is to create a blank Pivot Table and then drag and 
drop field names onto that blank table. This way you will see the resulting pivot table 
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magically appear and it will help you better understand the important relationship between 
the pivot pallet and the field name list. 
 
Let’s create a simple PivotTable. Start with an Excel worksheet data that contains several 
columns of data – the data must include column and row headings and it helps if the data is 
contiguous. Place your cursor anywhere in the data and select PivotTable from the Data 
menu in Excel 2003 and click Finish; or from the insert Ribbon in Excel 2007.  This process is 
shown below: Let’s start with a page of data summarizing the results of tax season as all of 
the time sheet entries have been entered onto a single worksheet as shown below.  
 

 
 
Place your cursor anywhere in the data and select PivotTable from the Insert Ribbon as 
shown below: 
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For learning purposes let’s right mouse click on the pivot table and select PivotTable Options, 
Display, Classic PivotTable Layout. Your screen will now appear as follows: 
 

 
 

I like for CPAs to learn how to use Pivot Tables in this view because it visually helps them 
understand the all important relationship better the blank pivot palette and the PivotTable 
field List, both elements of which are shown in the screen above. 
 
To proceed, simply drag and drop field names shown on the right onto the blank Pivot 
palette shown on the left. With each drop, your report grows larger. As an alternative you 
could use the check boxes next to field names – this functionality is new in Excel 2007. After 
added some data to your blank Pivot Palette, your data will look something like this: 
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Next format and filter the Pivot Report. Very quickly your report comes together as shown 
below. Notice the filter button has been applied and a Pivot table style has also been applied 
for appearance.  
 

 
 
Double clicking on any number in a pivot report will automatically produce a new worksheet 
complete with all supporting detail that comprises the summary number.  
 
There are a multitude of PivotTable options that can be applied to alter the appearance or 
behavior of your Pivot table.  
 
Key Points Concerning Pivot Tables are as Follows: 

 
a. You can create as many Pivot Reports as you want from your initial raw data page. Your raw 

data remains unchanged as new Pivot tables are created. 
 

b. As your raw data changes, your pivot tables are updated each time you press the refresh 
button. Or if you prefer you can set your PivotTables to update themselves at regularly 
scheduled intervals – say every ten minutes. 
 

c. A key to understanding PivotTables is understanding the relationship between the Blank 
Pivot palette and the PivotTable Field list. As data is selected in the list, it appears on the 
Pivot table Report.  
 

d. You can alter the PivotTable simple by dragging and dropping the field names in different 
locations on the Pivot palette, or in different locations in the PivotTable Field list Box. 
 

e.  PivotTables can be pivoted. 
 

f. PivotTables can be sorted by any Column. (Or by any row when sorting left to right) 
 

g. PivotTables can be Filtered. 
 

h. PivotTables can be Drilled. 
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i. PivotTables can be copied and pasted. 
 

j. PivotTables can be formatted using PivotTable Styles, as shown below. 
 

 
 

k. Subtotals and grand totals can be displayed or suppressed at the users desire. 
 

l. PivotTable Data can be shown as numbers or percentages at the users desire. 
 

m. PivotTable can not only be summed, it can be averaged, minimized, maximized, counted, etc. 
 

n. Blank rows can be displayed or suppressed at the users desire. 
 

o. A new feature called “Compact Form” organized multiple column labels into a neatly 
organized outline which is easier to read. 
 

p. PivotTables can query data directly from any ODBC compliant database. The PivotTable tool 
for accomplishing this task is not included in the ribbon – you will find it by Customizing the 
Quick Access Tool Bar and searching the “Commands Not Shown in the Ribbon” tab to find 
the PivotTable and PivotChart Wizard Option. 
 

q. Many accounting systems can push data out of the accounting system into an Excel 
PivotTable format – this is commonly referred to as an OLAP Data Cube. OLAP data Cube is 
just a fancy word for PivotTable – and there is no difference.  
 

r. PivotTables can automatically combine data from multiple data sources. The PivotTable tool 
for accomplishing this task is not included in the ribbon – you will find it by Customizing the 
Quick Access Tool Bar and searching the “Commands Not Shown in the Ribbon” tab to find 
the PivotTable and PivotChart Wizard Option. 
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s. Excel also provides a PivotChart function which works similarly to PivotTables. Presented 
below is an example PivotChart.  
 

 
 

Excel 2003 PivotTables work very similarly as shown below. Excel creates a blank PivotTable, 
and the user must drag and drop the various fields from the PivotTable Field List onto the 
appropriate column, row, or data section. As you drag and drop these items, the resulting 
report is displayed on the fly. Here is the blank Pivot Palette view. 
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Now drag and drop field names from the Pivot Table field list onto the Pivot pallet. This 
action will automatically create Pivot Table reports – and they will change each time you 
drop additional field names, or move field names around. Presented below are but a few 
examples of hundreds of possible reports that could be viewed with this data through the 
PivotTable format. 
 

 
 
This report shown above shows the total resulting sales for each marketing campaign for 
each of the 4 months marketing campaigns were conducted. 
 

 
 
In this screen we see the same information is shown as a percentage of the total. A few 
observations include the fact that overall Radio Spots are the most profitable type of 
campaign, but only in April and July. In January and October, local ads and direct mail, 
respectively, produce better results. Further, April campaigns had the best response overall. 
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Further analysis in the screen above tells us that our results vary widely from one city to the 
next. In New York, coupons were least effective, but coupons were most effective in 
Columbus. Pivot charts based on PivotTable data can be modified by pivoting and/or 
narrowing the data.  They can also be published on the Internet (or on an Intranet) as 
interactive Web pages.  This allows users to “play” with the data. The chart below provides a 
visual look at the data shown above. 
 

 
 
Filtering Pivot Tables - If you take a close look at your resulting pivot tables, you will notice 
that Excel automatically inserts a filter button on each field list as shown by the drop down 
arrows in the screen below:  
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This drop down filter list makes it easy to refine your report to include just the data you 
want. 
 
Drilling Pivot Tables - Another nice feature in pivot tables is that they are automatically 
drillable. Simply double click on any number in a pivot report top have Excel automatically 
insert a new sheet and produce the detailed report underlying the number you clicked on. 
An example of this is shown below: 
 

 
 
Pivot Table Options - By right mouse clicking on your pivot table you will reveal several 
option settings boxes as shown below. For example, these options boxes control the types of 
subtotals produced in your pivot reports. Excel also offers a pivot table options box as well as 
a layout wizard that makes producing pivot tables a little easier.  
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Data Table (“What-if Analysis”)  
 
Data tables are part of a suite of commands that are called what-if analysis tools. When you 
use data tables, you are doing “what-if analysis”. What-if analysis is the process of changing 
the values in cells to see how those changes will affect the outcome of formulas on the 
worksheet. For example, you can use a data table to vary the interest rate and term length 
that are used in a loan to determine possible monthly payment amounts.  
 
Three categories of What-if Analysis Tools - There are three kinds of what-if analysis tools in 
Excel:  
 

1. Data Tables 
2. Goal Seek 
3. Scenarios 

 
A data table cannot accommodate more than two variables. If you want to analyze more 
than two variables, you should instead use scenarios. Although it is limited to only one or 
two variables (one for the row input cell and one for the column input cell), a data table can 
include as many different variable values as you want. A scenario can have a maximum of 32 
different values, but you can create as many scenarios as you want. 
 
Loan Analysis - In this exercise, we start by creating a simple Payment function to calculate 
the payment amount of a loan given a loan amount, interest rate and number of periods.  
 

 
 

The next step is to create a “Two-Way Data Table” displaying the resulting payment amount 
given a variety of lengths of the loan. This process is started by creating a list of the 
alternative loan amounts, as shown below in B8, B9, B10, etc. Cell C7 must reference the 
results you want to be displayed in the table. 
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The next step is to highlight the data table range and use the Data Table command under 
the Data menu (as shown below) to generate the desired table. 
 

 
 

This process will generate the following table: 
 

 
 
This table tells us that the same loan amount will require a monthly payment of $3,331 to 
pay the loan off in just 10 years, and a monthly payment of $5,800 to repay the loan in just 
5 years.  
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The next step in this exercise is to generate a line chart based on the data table we just 
created. This line chart will provide some interesting observations regarding the benefits 
and detriments of paying off loans over longer periods. 
 

 
 

The resulting chart is shown as follows: 

 
 

Based on this, no one should ever obtain a fair market loan for more than 15 years, the 
reduction in payments simply aren’t worth the additional length of the loan. This same basic 
behavior is seen whether the interest rate is 1% or 100%. The only time you might be 
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justified in obtaining a loan loner than 15 years might be when you are extended a 
favorable interest – this better than a fair market interest rate. 
 

Goal Seek 
 
If you know the result that you want from a formula, but are not sure what input value the 
formula needs to get that result, use the Goal Seek feature. For example, suppose that you 
need to borrow some money. You know how much money you want, how long you want to 
take to pay off the loan, and how much you can afford to pay each month. You can use Goal 
Seek to determine what interest rate you will need to secure in order to meet your loan 
goal. Goal Seek works only with one variable input value. If you want to accept more than 
one input value; for example, both the loan amount and the monthly payment amount for a 
loan, you use the Solver add-in discussed at the end of this manual. 
 

Scenarios 
 
Scenario Manager allows you to create and save multiple “what if” scenarios (such as best 
case, most likely, and worst cases scenarios). You can also create a summary table of the 
scenario results in seconds.  It is particularly useful for worksheets such as budgets in which 
users have often saved multiple copies of the same worksheet to accomplish the same 
objective. An example is shown below. In this example, a tire company has prepared a 
revenue budget for the coming year, and has created three alternative scenarios to 
generate the revenues that will result given a variety of mark up assumptions – in this case 
100%, 110% and 120% markups. 
 

 
 



Excel Functions, Macros & Data Commands 

www.CarltonCollins.com Page 68 Copyright April 2011 
 

Pressing the summary button in the scenario manager dialog box will create the following 
Pivot Table of possible alternative results. Here we see detailed revenue projections for all 
tires and labor fees given all three possible scenarios of 100%, 110%, and 120% markup.  
 

 
 
With a few simple copy paste commands, the newly created data can be positioned and 
formatted next to the original projections as shown in the screen below. 
 

 
 
Of course the scenarios above could have been created easily using simple formulas instead 
of using the scenario manager tool as described above. This underscores that best purpose 
of scenario manager which is to keep track of older and changing data through time, rather 
than producing what-if scenarios. For example, a complex projection containing scenarios 
based on original assumptions, revised assumptions, and final assumptions will allow 
management to go back and review the assumptions used throughout the project, and see 
how those assumptions changed as project planning progressed. 
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Data - Text to Columns 

 
As discussed earlier in this manual, often CPAs receive data from their clients or IT 
departments that is in text form. When this happens, Excel can split the contents of one or 
more cells in a column and distribute those contents as individual parts across other cells in 
adjacent columns. For example, the worksheet below contains a column of full names and 
amounts that you want to split into separate columns. The Text to Columns Wizard parses 
the data automatically into separate  
 
Select the cell, range (range: Two or more cells on a sheet. The cells in a range can be 
adjacent or nonadjacent.), or entire column that contains the text values that you want to 
split. Note   A range that you want to split can include any number of rows, but it can include 
no more than one column. You also should keep enough blank columns to the right of the 
selected column to prevent existing data in adjacent 
 

 
 
 
 
 

 
Data Consolidate 
 
Excel can combine, summarize, and report consolidated results from separate worksheets. 
The underlying worksheets can be in the same workbook or in other separate workbooks. 
There are two different situations as follows: 
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1. You Are Consolidating Similar Data – Such as departmental budgets where every worksheet 
contains the exact same labels in the exact same cells. In this case, you can write a “Spearing 
Formula” which can consolidate the necessary information easily. 
 

2. You Are Consolidating Dis-Similar Data – The various worksheets contain different row and 
column descriptions located in different locations on the worksheets. In this case you should 
use the Data Consolidate command.  

 
For example, assume that you have received budgets from multiple departments, and you 
want to combine them together. In this case, Excel will do the work for you. You can use a 
consolidation to roll up these figures into a corporate budget worksheet, as shown below. 
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Data Grouping & Outlining  
 
If you have a list of data that you want to group and summarize, you can create an outline 
of up to eight levels, one for each group. Each inner level, represented by a higher number 
in the outline symbols displays detail data for the preceding outer level, represented by a 
lower number in the outline symbols. Use an outline to quickly display summary rows or 
columns, or to reveal the detail data for each group. You can create an outline of rows (as 
shown in the example below), an outline of columns, or an outline of both rows and 
columns. 
 

 
 
 

Web Queries 
 
Excel includes pre-designed “queries” that can import commonly used data in 10 seconds. 
For example, you could use a web query to create a stock portfolio. All you need is a 
connection to the Internet and of course, some stock ticker symbols. In Excel 2003 select 
“Data, Import External Data, Import Data” and walk through the web query wizard for 
importing stock quotes. In Excel 2007 and later use the Data Ribbon, Existing Connections, 
Stock Quotes option. In seconds, Excel will retrieve 20 minute delayed stock prices from the 
web (during the hours when the stock market is open) and display a grid of complete up-to-
date stick price information that is synchronized to the stock market’s changing stock prices. 
With each click of the “Refresh” button, the stock price information in Excel is updated  - 
this sure beats picking numbers out of the newspaper.  



Excel Functions, Macros & Data Commands 

www.CarltonCollins.com Page 72 Copyright April 2011 
 

 

 
 
Completing the Stock Portfolio – Next link the grid data to another worksheet, and insert 
new columns containing the number of shares owned, as wells as an additional column to 
computer the total value based on shares owned, as shown below. 
 

 
 
Refreshing the Stock Prices - Once you have created your portfolio, simply click the Refresh 
Data button on the “External Data” Toolbar in Excel 2003 or on the “Data Ribbon” in Excel 
2007 shown below to update the current value of your Portfolio. 
 

       
 
Query Parameters - There are numerous options to help you extract exactly the data you 
want they way you want it. The “Web Query Parameters Box”, “Web Query Options box” 
and “External Data Properties Box” provide numerous options for controlling your web 
query. 
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Database Queries  
 
Microsoft Excel can also query and retrieve data you want from an external data source. For 
example, you can retrieve Microsoft Excel data about a specific product by region. You can 
create a simple query by using the Query Wizard, or you can create a more complex query 
by using the advanced features of Microsoft Query. 
 
To use Microsoft Query to retrieve external data, you must: 
 

1. Have access to an external data source - If the data is not on your local computer, 
you may need to see the administrator of the external database for a password, user 
permission, or other information about how to connect to the database. 
 

2. Install Microsoft Query - If Microsoft Query is not available, you might need to 
install it. 
 

3. Specify a source to retrieve data from, and then start using Microsoft Query -   For 
example, if you want to insert database information, display the Database toolbar, 
click Insert Database, click Get Data, and then click MS Query.  

 
For example, suppose we have some data in our accounting system – Sage MAS 200 ERP 
that we would like to analyze in Excel.  We can use the Database Query Wizard to build a 
query that will extract the data we need and place it in an Excel spreadsheet. 
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The first step is to select the type of database you want to query and to select the specific 
database. 
 

 
 
Upon the selection of the desired database a list of tables will be presented. Choose the 
desired tables, and select the desired data fields to be imported. You will then have the 
option to filter and sort the data before it is imported.  Finally you will be given the option 
to save the query so that you can run it at a later date without having to start from scratch. 
Excel will then return a table full of the data you requested as shown in the screen below. 
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When boiling eggs, add a pinch of salt to keep the shells from cracking. 

 

http://lifehackery.com/2008/05/17/50-amazingly-helpful-time-tested-tips-for-the-kitchen/
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Chapter 5 

MACROS 
Automating Your Key Strokes  
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Macros 

  
Macros offer a powerful and flexible way to extend the features of Excel. They allow the 
automation of repetitive tasks such as printing, formatting, configuring, or otherwise 
manipulating data in Excel. In its’ simplest form, a macro is a recording of your keystrokes. 
While macros represent one of the stronger features found in Excel, they are rather easy to 
create and use. There are six major points that I like to make about macros as follows.  
  

Six Major Points for Creating Macros 
 

1.      Record, Use Excel, Stop Recording – To create a macro, simply turn on the macro 
recorder, use Excel as you normally do, then turn off the recorder. Presto – you have 
created a macro. While the process is simple from the user’s point of view, 
underneath the covers Excel creates a Visual Basic subroutine using sophisticated 
Visual Basic programming commands.   
  

2.      Macro Location – Macros can be stored in either of two locations, as follows: 
  

a.      The workbook you are using, or  
b.      Your Personal Macro Workbook (which by default is hidden from view) 

  
If your macro applies to all workbooks, then store it in the Personal Macro 
Workbook so it will always be available in all of your Excel workbooks; otherwise 
store it in your current workbook. A macro stored in your current workbook will be 
embedded and included in the workbook, even if you e-mail the workbook to 
another user.  
  

3.      Assign your Macro to an Icon, Text or a Button – To make it easy to run your macro, 
you should assign it to a toolbar icon so it will always be available no matter which 
workbooks you have open. If the macro applies only to your current workbook, then 
assign it to Text or a macro Button so it will be quickly available in your current 
workbook. 
  

4.      Absolute versus Relative Macros – An “Absolute” macro will always affect the same 
cells each time whereas a “Relative” macro will affect those cells relative to where 
your cursor is positioned when you invoke the macro. It is crucial that you 
understand the difference. 
  

5.      Editing Macros – Once created, you can view and/or edit your macro using the View 
Macros option. This will open the macro subroutine in a Visual basic programming 
window and provide you with a plethora of VB tools. 
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6.      Advanced Visual Basic Programming – For the truly ambitious CPA, in the Visual 
Basic Programming window, you have the necessary tools you need to build very 
sophisticated macros with dialog boxes, drop down menu options, check boxes, 
radio buttons – the whole works. I invite you to knock yourself out. To see all of this 
power, turn on the “Developer Tab” in “Excel Options” (see below).  

  
Presented below are more detailed comments and step-by-step instructions for creating 
and invoking macros, followed by some example macros.  
 

Steps for Creating A Macro 
  
1. Launch Macro Recorder - Select Record Macros on the View tab, or in the Code Group 

on the Developer Tab. 
 

2. Macro Name - Enter a name for the macro In the Macro Name box. 
 

a. The first character of the macro name must be a letter.  
b. Subsequent characters can be letters, numbers, or underscore characters.  
c. Spaces cannot be used in a macro name (an underscore character is often used 

as a word separator.  
d. If you use a macro name that is also a cell reference, you may get an error 

message that the macro name is not valid. 
 

3. Shortcut – (This is optional) Assign a CTRL key combination (such as CTRL+A to run the 
macro by typing any lowercase letter or uppercase letter that you want to use in the 
Shortcut key box. 

 

a. The shortcut key will override any equivalent default Excel shortcut key while 
the workbook that contains the macro is open.  

  
4. Macro Location - In the Store Macro In dropdown box, select the workbook where you 

want to store the macro.  
 

a. If you want a macro to be available in all Excel workbooks, select Personal 
Macro Workbook. When you select Personal Macro Workbook, Excel creates a 
hidden personal macro workbook (Personal.xlsb) if it does not already exist, and 
saves the macro in this workbook.  
 

i. In Windows Vista, this workbook is saved in the 
C:\Users\username\AppData\Local\Microsoft\Excel\XLStart folder.  

ii. In Microsoft Windows XP, this workbook is saved in the C:\Documents andSettings\user 
name\Application Data\Microsoft\Excel\XLStart folder.  

iii. Workbooks in the XLStart folder are opened automatically whenever Excel starts.  

javascript:AppendPopup(this,'ofShortcutKey_3_3')
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b. Note - If you want the macro in the personal macro workbook to be run 
automatically in another workbook, you must also save that workbook in the 
XLStart folder so that both workbooks are opened when Excel starts. 

  
5. Macro Description - In the Description box, type a description of the macro.  

  
6. Start Recording - Click OK to start recording.  
  
7. Start Typing - Perform the actions that you want to record. New in Excel 2010, macros 

can now record the manipulation of objects, such as inserting or moving a text box.  
  

8. Stop Recording – When you are done click “Stop Recording” in the “Code Group” On 
the “Developer Tab”. You can also click Stop Recording on the left side of the status bar. 

  
9. Assign the Macro to an Object, Graphic in the Worksheet – Insert an object (like a Star 

shape or text box) or graphic image (like a picture) in your worksheet, then right-click on 
that object or graphic image and select Assign Macro from the popup menu. In the 
Macro Name box, select the macro that you want to assign to that object or graphic 
image and click OK. 

 

10. Menu Navigation Not Recorded – Keep in mind that when you record a macro, the 
macro recorder records all the steps required to complete the actions that you want 
your macro to perform. Navigation on the Ribbon is not included in the recorded steps, 
only the commands that are executed are recorded in the macro. 

 

11. Turn On The Developer Tab – By default, the Developer tab is turned off, but you can 
turn it on in Excel 2010 by clicking the File tab select Options, Customize the Ribbon, 
and check the checkbox next to Developer Tab.  In Excel 2007, click the Microsoft Office 
Start Button in Excel 2007, select Excel Options, and under the Popular category, Top 
options for working with Excel, select the Show Developer tab in the Ribbon check 
box, and then click OK. 

 

12. Enable Macros – If the macro functions are disabled, you can enable them by selecting 
Macro Security in the Code group on the Developer tab as shown below. 

  

 
  
Under Macro Settings, click Enable All Macros (this is not recommended by Microsoft 
because potentially dangerous code can then run without your approval), and then 
click OK.  
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13. Example Macros You Might Find Useful 

 

A. Insert Headers and Footers Macro – Start recording a new macro called 

Insert_Headers. Select all of the worksheets, then from the Page Layout tab, double 

click the Page Setup dialog box button to display the Page Setup dialog box. 

Continue to customize the header and footers to include page numbers, date and 

time stamps, file locations, tab names, etc. Assign the macro to an Icon on your 

toolbar or Quick Access Bar for quick and easy access. Thereafter, inserting headers 

and footers in your worksheets will be a breeze. 

 

B. Print Macros – Do you have a workbook containing multiple reports that you 

frequently print? If so, insert macro buttons to print each individual report, a group 

of reports, and even multiple reports, and in the future reporting will be a snap.  

 

C. Delete Data Macro – Do you have a frequently used template that contains a lot of 

variables? If so, create a macro that visits each cell and erases that data, resetting 

the worksheet for use in a new set of criteria. Assign the macro to a macro button 

and you will never again have old assumptions mixed in with your newer template. 

 

D. Macro Case Study – Carlton’s Copy Shop – See the following chapter for a detailed 

case study for using macros.  

  
 
 
 
 
 

If you aren’t sure how fresh your eggs are, place them in about four 
inches of water. Eggs that stay on the bottom are fresh. If only one end 
tips up, the egg is less fresh and should be used soon. If it floats, it’s past 
the fresh stage. 
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Chapter 6 

Copy Shop Sales Order  
Case Study 

 
 
As an accounting software installer, I’ve learned from experience that most businesses can 
pick blindly from among the top accounting systems in the world and pretty much get the 
job done. From one business to the next, accounts payable needs, payroll needs, trial 
balance needs, reporting needs, and even inventory needs are similar and well covered by 
today’s top accounting systems. However, there is one area which differs dramatically  - and 
that area is in the sales order. It turns out that each company sells differing kinds of 
products and services with options so varied, that few accounting systems are prepared to 
handle those needs. In this situation, I make a bold claim that an Excel template can be 
easily used to fill in the missing gaps and supplement any accounting software system to 
provide excellent order taking capabilities. 
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In this case study, let us assume that we are working with a small copy shop – a small family 
owned company with about $300,000 in revenue. In this case they have determined that 
QuickBooks meets all of there needs, except for order taking. Therefore our goal will be to 
build  a Sales Order system using Excel in only a few minutes. Listed below are the key 
elements that you will learn in this case study: 
 

1. Neat and Organized Worksheet Design 
2. =NOW() 
3. Data Validation Lists 
4. =VLOOKUP 
5. Creating Macro Buttons 
6. Creating Macros 
7. Relative versus Absolute Macros 
8. Worksheet Protection 

 
Think about a copy shop for a minute, what is so difficult about taking an order in a copy 
shop? It is the options. How many copies would you like? Do you want that printed on front 
and back? Stapled or Bound? What kind of binding? What size paper? What color paper? 
What pound paper? Do you want regular or fast delivery? These are all standard questions 
asked by a copy shop, yet QuickBooks, nor any high end accounting system is able to take 
such an order. Even the million dollar solutions aren’t equipped to take such an order. 
These companies must instead resort to purchasing a software application called a “product 
configurator”, solutions which can costs $75,000 to $750,000 or more. To make matters 
more difficult, there are often rules associated with various options – for example, when 
ordering a car, if you order the sun roof option, you can not also order the T-Top option. 
Product configurators must account for and accommoate these types of situations. 
 
1. Let us begin by simply labeling our sales 

order form. As you can see in the screen 
to the right, we’ve added some labels and 
highlighted some data input fields with 
yellow background and gridline borders.  

 
(For purposes of this case study, we will 
only build in options for color and size, 
but once you get the hang of it, adding in 
additional options for paper weight, 
binding, duplex printing, etc is a rather 
simple matter.) 
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2. =NOW() – Next we type in the Excel Function =NOW(). This will cause Excel to 
display the computer’s date and time each time an order is produced. You can see 
the =NOW() function in the formula bar and the results displayed in cell B2 below. 
 

 
 

3. Calculations for Base Rate – Next we add simple calculations to multiply the total 
number of pages to be copied by the total number of copies and the base rate per 
copy. To make it easier to visualize, I have added some customer data. (The formula 
contained in cell B11 is displayed in the formula bar.)  
 

 
 

4. Color Options – Next I created a table of the color options along with a sur-charge rate per 
page for each color. Notice that there is a “zero” sur-charge when selecting white paper. 
Make sure to sort your table in descending order because we plan to refer to that table via a 
Lookup function – and as we all know, lookup functions do not work properly unless the 
table array is sorted in descending order. To make the table of options more readable, I 
applied gridlines and a greenish background.  
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5. Data List Validation – Now this is where the excitement begins. Next I create a data 
validation list in cell B13 using column one of my options table. To do this, select B13, and 
choose Data validation from the Data Ribbon. Next select List and use the Cell Chooser to 
highlight the options in column one of your color options table.  
 

   
 

 
 

6. =VLOOKUP – Next I inserted a =VLOOKUP function in cell B14 to return the Sur-Charge rate 
based on the Color Selected. 
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Notice that when you select different colors in cell B13, the rate in Cell B14 changes 

according to the Color Option table. 

 

7. Size Options - Repeat steps 4,5 & 6 above to also create Size Options.  

 

 
 

8. Invoice Total – From here it is an easy step to add calculations to total the invoice. Of course 
your complete invoice would also include sales tax calculations as well. Our example is kept 
as simple as possible to make sure that the key points come across as easy as possible. 
Here’s what we have so far: 
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9. Macro Buttons – To make the Sales Order form easier to use, next we will add three macro 

buttons. We start this process by creating a single text box, and using the Drawing Tools to 
make it look fancy. Here are steps: 
 

      

 
10. Create the Print Macro – Next create a print macro by selecting “Macro, Record Macro” 

from the “View Ribbon” (make sure that no spaces are used in your macro name and save 
the macro to “This Workbook). Set the “Print Area” appropriately to display your Sales Order 
Form. Next simply highlight your Sales Order Form and print three copies, then stop 
recording your macro by selecting “Macro, Stop Recording” from the “View Ribbon”. Once 
completed assign the Macro to the Print Sales Order Button by right mouse clicking and 
selecting “Assign Macro”.   The right click menu as well as the Assign macro Dialog box are 
shown in the two screens below. 
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You want to print three copies of the Sales Order as follows: One for your customer’s 
records; One for your product people to follow when making the copies, and one for 
bookkeeper to use when entering the invoice amount into QuickBooks.  

 
11. Additional Macro Buttons – Next right click on the edge of the existing macro 

button twice, and choose “Copy”; then click away from the button and Paste twice. 
This will create two exact copies of your macro button. (You must right click twice on 
the edge of the button to display the second menu of options.)  

 

 
 

Next select the “Select Objects” menu option from the “Home” Ribbon’s “Find and 
Select” menu in the “Edit” Group. Then lasso the three buttons and from the 
“Drawing Tools”, use the Alignment tools to left justify and Distribute Vertically the 
three buttons. 
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The results will appear as follows: 
 

 
 

Press escape to deselect the “Object Pointer” tool, and return your cursor to normal. 
 

12. Post Sales Order Macro Button – Next I created a macro to post the sales order information 
to a database. This is complicated and I will demonstrate several teaching points in class to 
help you fully understand the process of writing a combination relative and absolute Here 
are the steps: 
 

a. Relabel the second Macro Button to Read “Post Sales Order”. This will require you 
to first right mouse click on the button and select the text, or if you prefer, remove 
the macro before continuing.  

b. Highlight cells B2 thru B21 and label that range “salesorderdata” using the Name 
Box. 

c. Go to Cell H1 and enter the phrase “Database” in cell H1. 
d. Label cell H1 “database” using the Name Box. 
e. Copy the labels in cells A2 thru A21 and Paste Transpose them to cell H2. 
f. Start recording a macro named “postsalesorder”. 
g. Click the “Use Relative References” option from the Macros Group on the View 

Ribbon. 
h. Press the F5 key to launch the GoTo Dialog Box.  
i. Select the range “salesorderdata” by double clicking on the word “salesorderdata”. 
j. With your cursor hovering above the selected range, right mouse click and choose 

“Copy”. 
k. Press the F5 key to launch the GoTo Dialog Box.  
l. Select the range “database” by double clicking on the word “database”. 
m. Press the End key, followed by the Down Arrow. (You will now be on the last row.) 
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n. Press the Down Arrow. (You will now be on a blank row underneath the last row.) 
o. With your cursor hovering above the selected range, right mouse click and choose 

“Paste Special”. 
p. In the paste Special Dialog Box, check Values and Check Transpose, and click OK. 
q. Place your cursor on cell A1. 
r. Stop recording the macro by selecting “Macro, Stop Recording” from the “View 

Ribbon. 
s. Assign the newly recorded macro to the Post Sales order macro Button. 
t. Select Column H and format it to display Time and Date. 
u. Adjust the width of your database columns to your preference. 

 
13. New Sales Order Macro Button – Finally, edit the Third macro Button to Read “New sales 

Order” and create a macro that selects the yellow background data cells and deletes the 
contents. (Make sure to toggle the “Use Relative References” option off because this macro 
needs to be an absolute macro.) (Also make sure to select Cell B4, then hold the CTRL key 
down while you also select the other yellow back ground cells). Before you Stop Recording 
this macro, click on cell B4 so your cursor will be in the correct place to start recording a new 
sales order. 

 

 
 

14. Testing – Test your three macros by filling in new sales order information, then click the 
three macro buttons in sequence to print, post and delete your data. 
 

15. Unlock Data Input Cells – Next, select the cells containing the yellow background and also 
select the database columns (Hold the CTRL key down to make multiple selections. Then 
format the those cells to unlock them by right mouse clicking atop your selection and 
selecting “Format Cells, and unchecking the Locked Box on the protection tab – as shown 
below: 
 



Excel Functions, Macros & Data Commands 

www.CarltonCollins.com Page 90 Copyright April 2011 
 

 
 

16. Protect Your Worksheet - Finally turn on worksheet protection by selecting “Protect Sheet” 
from the Review ribbon. Enter a password and repeat the password. This will prevent you or 
others from making accidental changes to the formulas and data contained in your 
template. 
 

17. Keep in Mind – This case study covered the basics, but you could enhance this template a 
number of ways. Here are a few example hints: 
 

a. Combine the three macro buttons into one button that performs all tasks – printing, 
posting, and deleting. 

b. You might add an invoice number to the top of the page. Each time you post, your 
macro might also create a temporary formula in an empty cell that refers to the 
invoice number and adds one, then copies pastes that result atop the invoice 
number cell using the paste value command. Make sure the macro then deletes the 
formula in the temporary cell. 

c. You could easily add more options to your order form.  
d. Notice that we also included an option to decrease our price if a smaller paper size 

is selected.  
e. The sales order form could be dressed up to look far more professional. Colors, 

grids, logos, etc. could all be added to make the sales order form match the 
accounting system, for example. 

f. You could copy the worksheet and edit a second order for to be used in different 
situations. For example, Worksheet A might contain an order form that charges 
regular rates when a regular customer enters the store, and Worksheet B could 
charge higher rates when a lawyer enters the store – and so on. 

g. The resulting database will continue to compile each sales order as posted, adding 
new orders to the bottom of the database area each time you post. 

h. The bookkeeper need only record the date, customer name, address, and total 
amount  due in QuickBooks. The printed Sales Order copies on file will serve as 
supporting documentation. 

i. You can download a copy of this example template from www.CarltonCollins.com – 
click the Excel Link. 

 
 
 
 
  Plan and book your vacations well in advanced, that we you will get to 

look forward to them longer, and you may benefit from research and 
feedback you get from your friends for making the trip more enjoyable. 

http://www.carltoncollins.com/
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Chapter 7 

Miscellaneous 
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Excel’s Solver  
 
Solver is one of the more powerful features in Excel because it can solve for optimum 
results in complex worksheets while obeying stated constraints.  With Solver, you can find 
an optimal value for a formula by manipulating a group of cells that are related, either 
directly or indirectly, to the formula in the target cell. Solver adjusts the values in the 
adjustable cells to produce the result you specify from the target cell formula. You can apply 
constraints to restrict the values Solver can use in the model, and the constraints can refer 
to other cells that affect the target cell formula. 
 
In the portfolio example shown below, the user wishes to determine how much money to 
invest in various investments in order to maximize the return on those investments. Of 
course the maximum results can be achieved by simply place in all monies in the investment 
that yields the highest results, however this approach violates the “don’t put all of your eggs 
in one basket rule”. In this case the user wants to diversify their funds across many types of 
investments. Therefore constraints are established such as no more than 35% of funds can 
be invested in blue chip stocks and the checking accounting must contain at least $100,000. 
 
A portfolio is shown below and some constraints have been included in lust form. These 
constraints will need to be stated in terms of formulas in the solver manager dialog box. 
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The key to making solver work is the solver Parameters dialog box shown below. 
 

  
 

The target cell is set to refer to the total portfolio value at the end of the year because this 
is the value that we want to maximize. The changing cells are set to reference the 
percentages of each investment. Finally the various constraints are expressed as formulas as 
shown in the lower left hand corner of the dialog box. Once solver has been run once, the 
solver formulas stick to the worksheet and the results are changed and updated as the 
various assumptions in the worksheet are changed and updated. For example, you may 
later determine that the growth rate for real estate is a different amount. Inputting that 
new amount in the worksheet will cause Excel to automatically adjust all variables to 
produce the optimum investment mix that maximizes earnings without violating any stated 
constraints. 

 
Creating a New Worksheet can be a Drag 
 
Q. How can I insert new worksheets in my Excel workbook without having to constantly 
setup new headers and footers in those new worksheets?  
 
A. Excel 2003, 2007 and 2010 allow you to duplicate a worksheet by holding the Ctrl key 
down and dragging the worksheet’s tab to the left or right. This action will insert a new 
worksheet, complete with the same headers, footers, margins, column widths, and cell 
contents, as the original worksheet. (In many situations, this method is quicker and easier 
than inserting a new worksheet and then adding headers, footers, margin settings and 
content.)   
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Alternative Approach: You can achieve the same results using the menus by selecting a 
worksheet tab (or group of tabs), right-mouse clicking on that worksheet tab (or group of 
tabs), selecting Move or Copy, checking the Create a copy checkbox, and clicking OK. 

 

Hint: You can also use this procedure to duplicate multiple worksheets at the same time. To 
do this, select the first worksheet to be duplicated by clicking on the worksheet tab. Next, 
while holding down the Shift key, select the last worksheet to be duplicated by clicking on 
its’ tab. (This action will select those two tabs, and all worksheet tabs in between.)  
Complete the copy by holding the Ctrl key down and dragging the group of worksheet tabs 
to the left or right.  

 

A Refreshing Change in Your Portfolio  
 
Q. I’ve heard that you can create a stock portfolio in Excel that is updated automatically via 
the Internet. Can you please tell me if this true, and if so how this is accomplished? 
 
A. You’ve heard correctly. Excel provides a built-in query tool that can link your worksheet 
to 20-minute delayed stock quote information. This query tool uses Open Database 
Connectivity (ODBC) to establish a permanent connection between the source data and 
your Excel workbook. Once the link has been created, your Excel workbook can be updated 
with current stock price information simply by clicking the Refresh button. To build an 
ODBC-based stock portfolio, make sure that your computer is connected to the internet, 
and create a  basic portfolio as suggested in the screen image below: 
 

 
 
Be sure to include valid ticker symbols for each of the stocks, mutual funds, ETFs and other 
investments you own. Next, create the query as follows: 
 

1. Launch the Import Data dialog box as follows: 

 
a. In Excel 2007 and 2010, from the Data Ribbon, select Existing Connections from the 

Get External Data Group. This action will launch the Existing Connections dialog 
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box. In the Existing Connections dialog box, select MSN MoneyCentral Investor 
Stock Quotes. 

b. In Excel 2003, from the Data Menu select Import External Data, Import Data. This 
action will launch the Select Data Source dialog box. In the Select Data Source 
dialog box, select MSN MoneyCentral Investor Stock Quotes. 
 

2. In the Import Data dialog box, select the option for New worksheet as shown below, and 
click OK to display the Enter Parameter Value dialog box. 
 

 
 

In the Enter Parameter Value dialog box, click the Cell Chooser icon and highlight the cells 
in your portfolio containing the stock ticker symbols as shown below. Check the box labeled 
Use this value/reference for future refreshes and click OK.  

 

 
 

This action will retrieve and display an array of stock quote information from the MSN 
MoneyCentral Investor database in a new Excel worksheet. This information includes the 
name of each investment and 20 minute delayed price per share data, among other 
information. An example of the resulting stock quote query is shown below. 
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Return to your portfolio worksheet and fill in the missing name and stock price information 
using simple reference formulas to refer to the investment names and stock price 
information on the query worksheet. For example, select cell D3 in your portfolio 
worksheet, and enter the formula =QueryWorksheet!D4 (assuming the worksheet 
containing your query is named QueryWorksheet). Thereafter, each time you click the 
Refresh All button, Excel will update the query results, which in turn will update your 
portfolio.   
 

 
 

Tip 1: If you plan to print your portfolio report, insert the formula =NOW() in cell A1 (or any 
blank cell) to ensure that the date and time your portfolio was printed appears on the 
report. 
 
Tip 2: If you prefer to use the Refresh button (ie: instead of the Refresh All button), you 
must first select a cell (or cells) within the query.  
 
Tip 3: If you later add more line items to your portfolio, you can change the query 
parameters by right mouse clicking on the query and selecting Parameters from the drop 
down menu.  
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 XPS versus PDF 
 
Q. I see that Microsoft Office 2007 and 2010 offer a new format called XPS.  I have read that 
this new format supports the paperless environment and I wonder if our firm should be 
using this format as we go paperless. Can you tell me what this is?  
 
A. XPS (XML Paper Specification) is a new format developed by Microsoft that offers an 
alternative to Adobe System’s PDF (Personal Document Format) format. A key advantage of 
both XPS and PDF formats is that the fonts used in the document are embedded in the file 
so that the document will display and print properly on other computers and printers. For 
Word 2007 and 2010 users, an advantage of the XPS format is that no additional software is 
required to view the XPS based documents because Microsoft Word automatically views 
documents with the XPS format. However, PDF documents require the user to download a 
PDF reader, such as the Acrobat Reader in order to view the document.  To create an XPS 
document in Word 2007 or 2010, from the Office Start button or File tab, select Save As, 
and select the XPS Document option form the Save as type: drop down box shown below, 
provide a file name in the File name: box, and click OK.   
 

 
 
Be aware that once you have saved a Word document as a PDF or XPS file, it cannot be 
easily edited or converted back to a Microsoft Office file format without specialized 
software or a third-party add-in. Both PDF and XPS file formats are frequently used to 
produce finalized documents to be shared. For example, financial reports, tax returns, legal 
documents, contracts, newsletters, and resumes are examples of documents that are 
commonly converted to PDF or XPS formats prior to sharing.   
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Excel’s New Slicer - It Slices, it Dices… 
 
Q. We maintain a large amount of data for more than 100 restaurants and we analyze sales 
and expenses daily, weekly and monthly by location, city, state and territory, and even by 
type of restaurant. Overnight, the results of operations for the previous day feed into a 
database and we analyze the data in Excel using pivot tables. Despite preparing dozens of 
reports, my superiors desire more detailed reports and analysis. Can you offer a good 
solution?   
 
A. Excel 2010’s new Slicer may be the answer you are looking for. Slicer is an enhancement 
to Excel 2010’s PivotTables that inserts filter boxes that your superiors can click to display 
precisely the reports they desire. To use Slicer, position your cursor anywhere in a 
PivotTable report and from the Insert ribbon, select Slicer from the Filter group. This action 
will open the Insert Slicers dialog box shown below.  
 

 
 
Place a checkmark in the checkbox for each slicer you want to display and click OK. Excel 
will insert slicer dialog boxes containing filter buttons in the worksheet for each field name 
you select, as shown below. 
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Simply click the various filter buttons to display different views of your data. For example, 
the report below summarizes revenue for those “Dine-In” and “Drive-Thru” restaurants 
managed by “Caroline” and “Madison” in the “Atlantic” and “Great Lakes” regions. (Holding 
down the Ctrl key allows you to make multiple selections within a Slicer dialog box.) The 
selected filter buttons are highlighted and the non-selected filter buttons are greyed out, 
allowing you to see which filters have been applied to the report. 
 

 
 
In the example shown above, the reader could produce up to 720 different views of this one 
report (9 States times 4 Types times 4 Territories times 5 Sales Reps). In your situation, you 
could add three similar PivotTable reports summarizing your data by week, month, and 
quarter, and e-mail the entire workbook to your superiors. This would limit the total 
number of reports you would need to prepare to just four, yet provide your superiors with 
the ability to view the data thousands of different ways, according to their preference.   
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Advanced Tip: A Slicer can be shared with multiple PivotTable reports so that when filters 
are applied in one Slicer, multiple PivotTable reports are filtered. To share a Slicer, click on 
the Slicer to be shared to display the Slicer Tools, Options tab. In the Slicer group, select 
PivotTable Connections and place a checkmark next to the PivotTables you want to share 
the Slicer as shown below.  
 

 
 
Hint: You can resize and re-position your slicers on the worksheet, and apply matching 
styles to both the PivotTables and Slicers to produce professional looking results.  
 

E-Mail a Single Worksheet 
 
Q. What is the easiest way to send a single Excel worksheet to a staff member without 
sending them the entire workbook? 
 
A. You can send a single worksheet (ie: not the entire workbook) from within Excel using the 
integrated Outlook Send this Sheet applet, as follows: 

 

1. Launch the E-Mail dialog box tool as follows: 
 

In Excel 2003 - Select File, Send to Mail Recipient. 

 

In Excel 2007 and 2010 – Right mouse click on the Quick Access Toolbar and select Customize 

Quick Access Toolbar. In the Choose commands from: drop down box, select Commands Not in 

the Ribbon. Scroll down and select Send to Mail Recipient, and click the Add>> button to 

include this command on your Quick Access Toolbar. Click OK. Click the Send to Mail Recipient 

icon on the Quick Access Toolbar.   

 

2. In the E-Mail dialog box, select the radio button labeled Send the current sheet as the message 
body, and click OK.  
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3. This action will create an e-mail message using the worksheet contents as the e-mail message 
with limited Outlook tools and functionality as shown below. Indicate the e-mail recipients and 
subject as you would normally when preparing an E-mail message and click Send the Sheet.   

 

 
 

The Send This Sheet menu is integrated with Outlook so that the To…, Cc…, and Bcc… drop 
down fields will display your contacts and contact groups you maintain in Outlook. Once the 
e-mail is sent, a copy of the e-mail appears in your Outlook Sent Items box, similar to that of 
a regular e-mail. 
 
Cautionary Note 1: When using this Send the current sheet as the message body option, 
the Excel data is converted from an Excel format into a table format containing only values. 
To send a single worksheet with the Excel formulas intact, make a copy of the workbook, 
delete all of the worksheets except for the one you intend to send, and repeat the steps 
above using the Send the entire workbook as an attachment option.  
 
Cautionary Note 2: When sending e-mails from within Excel, your default signature block is 
not inserted into the e-mail. 
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Cautionary Note 3: This functionality works well with Outlook, but does not necessarily 
work with other e-mail client applications.  

 
Displaying a Two Digit Year 
 
Q. How can I force Excel to display a two-digit year (instead of a four-digit year) by default?  
 
 
A. Many of Excel’s default settings are determined by the setting in the Windows Regional 
and Language Options. To adjust these settings, launch the Regional and Language Options 
dialog box as follows: 
 

1. In Windows XP, launch Control Panel from the Start Menu, and double click the Regional 
and Language Options icon. 
 

2. In Windows Vista and Windows 7, launch Control Panel from the Start Menu. Select System 
and Maintenance, then in the left hand menu select Clock, Language, and Region, Regional 
and Language Options. 

 
In the Regional and Language Options dialog box, click the Customize this format…to open 
the Customize Regional Options dialog box. On the Date Tab, click the Short date: drop 
down arrow in the Date formats group and select a date format that includes a two-digit 
date as shown below.  

 
 
You must close and restart Excel for this change to take effect. Thereafter, Excel will display 
the two-digit date format you specified as the default. 
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Cautionary Point: It is important to understand that even when you are displaying 2-digit 
years, you should still make it a habit to enter 4-digit years, otherwise Excel may assume the 
wrong century. This is because Excel interprets two-digit years ending in 00 through 29 as 
years 2000 through 2029. (For example, if you type the date 6/2/20, Excel assumes the date 
is June 2, 2020.) However, Excel interprets two-digit years ending in 30 through 99 as years 
1930 through 1999. (For example, if you type the date 6/2/60, Excel assumes the date is 
June 2, 1960.) You can change the way Excel interprets two-digit years by adjusting the 
Calendar setting located at the bottom of the Customize Regional Options dialog box 
(shown above).   
 

 

Dating Tips 
Q. When entering dates in Excel, it would be much simpler if I could enter the date as just 
the numbers without the forward slash character – 061010 or 06102010 instead of 
06/10/10 or 06/10/2010. Entering the slash makes the exercise a two-handed exercise 
instead of one-handed exercise via the numeric keyboard. Is there a way to enter data into 
just one cell so I can avoid using multiple cells and then concatenating? 
 

A. You can enter dates into Excel 2003, 2007 and 2010 without using slash marks by 
applying a custom format. Start by highlighting the range of cells and right-mouse click on 
that range to display the pop-up menu. Select Format Cells to display the Format Cells 
dialog box. On the Number tab select Custom, and enter the following custom format in the 
Type box: 00\/00\/0000, then click OK. (Because the forward slash has special meaning in a 
custom format, you must precede it with a backslash for Excel to recognize the slash mark 
as a literal character, not its special meaning.) Thereafter, dates entered without slash 
marks will display slash marks, and the date will behave like a date instead of text. An 
example is shown below.  
 

 
Once created, Excel remembers the custom format so you won’t have to create it again in 
the future. 
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Hint: To display dates without the preceding zeros, use this custom format. ##\/##\/##.  

 
Hide Me Quick 
Q. I am constantly hiding, un-hiding and re-hiding columns to generate reports in a 
multitude of report layouts, and I can’t figure out how to display only the hidden column 
that I need without having to display all my hidden columns? Can you help? 
 
A. Because hiding and un-hiding columns is a frequent task for many CPAs, I will address 
your specific question, and then offer a different solution. To unhide a specific column in 
Excel 2003, 2007 or 2010, press the F5 key to launch the Go To dialog box and type in any 
cell address within that column (such as G1), and click OK. This will place your cursor within 
column G, even if hidden. Next, type the keyboard shortcut sequence Alt, O, C, U to unhide 
the column.  
 
Alternatives – There are many alternatives for un-hiding columns, several of which are 
presented below so you can use the approach that work’s best for you. 
 

1. Menu Options - To unhide a column using the menu in Excel 2007 and 2010, from the Home 
tab, select Format from the Cells group, Hide & Unhide, Unhide Columns. To unhide a 
column using the menu in Excel 2003, select Column, Unhide from the Format menu.   

2. The Traditional Unhide Shortcut - In Excel 2003, 2007 and 2010, Windows XP users can 
unhide a column by typing Ctrl + Shift +), but this keystroke combination appears to be 
inactive in Windows Vista and Windows 7.  
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3. Column Width - Instead of un-hiding a column, you could simply increase the column width 
to make it visible. Start by pressing the F5 key to open the Go To dialog box and enter a cell 
address to go to a hidden column. To resize column widths in Excel 2007 and 2010, from the 
Home tab, select Format from the Cells group, Column Width, enter the desired width, and 
click OK. To resize a column width in Excel 2003, from the Format menu select Column, 
Width, enter the desired width, and click OK.  

 
Advanced Hint: To make your task easier, assign a name to a cell in each column you wish 
to hide or unhide using the Name Box (located just above the Column A heading). For 
example, you might assign the name YTD to cell G1, and the name Budget to cell H1. This 
will make it easier for you to use the Go To command because the name makes it obvious 
which column is which, whereas you might have a difficult time remembering which column 
label is which. Further, you could also use the Name Box to assign a name to a group of 
columns, and use the same procedure described above to hide or unhide that group. For 
example, you might assign the name PriorYear to cells J1 thru M1, and use the Go To 
command to go to those columns and unhide the entire lot.  
 
A Better Suggestion - Rather than constantly hiding and un-hiding columns, a better 
approach would be to use the Custom Views feature in Excel 2003, 2007 and 2010. By 
creating custom views, you can easily toggle back and forth between all of your views. To 
create your first custom view, unhide all of your columns and from the View tab (or View 
menu in Excel 2003), select Custom Views. Click the Add button and enter a description in 
the Name box, then click OK. Next, hide various columns in your workbook and repeat 
these steps to create a second view of your data that includes selected hidden columns. 
Continue to create additional custom views for each of your desired hidden column layouts. 
Thereafter, you can reduce or eliminate the need to hide and unhide columns in the future 
by simply changing the view. To toggle between custom views, from the View tab by select 
Custom Views in the Workbook Views group, and double click the desired custom view as 
shown below. 
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Animate Excel Charts in PowerPoint by Data Series 
 
PowerPoint 2010 allows you to animate your charts by data series as follows. Start by 
creating a chart in PowerPoint, or if you prefer, copy and paste a chart from Excel into 
PowerPoint. Click on the chart to select it, and click Animation Pane from the Animations 
tab to display the Animation Pane. Again, with the chart still selected, from the Animation 
tab, click Add Animation and select an Entrance animation such as Bounce, for example.  

 
In the Animation Pane click the drop down arrow next to the animation and click Effect 
Options to open the Bounce dialog box. Next, on the Chart Animation tab, click the Group 
chart drop-down arrow and select By Series, and click OK. Thereafter, when you display the 
slide show, each data bar series will bounce in individually, helping your audience identify 
the specific data series you are discussing. The screenshot below depicts the data series for 
sales representative Scott as the bars are bouncing into position. 
 

 
 

Hints: The ability to animate charts by data series first appeared in PowerPoint 2007, 
and the instructions are similar, but not identical to those described above. This 
feature is not available in charts that contain links to other applications, such as 
Excel.   

 
An Excellent Arrangement 
Q. Last year my office upgraded to two monitors at each workspace.  Having simultaneous 
full-screen views of two different files is a vast improvement over split-screen windows.  Is it 
possible to display a different tab from the same Excel worksheet on two monitors? 
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A. Start by displaying Excel across both monitors as follows: Click the Restore Down button 
in the upper right corner of the Excel window. Use the mouse to drag the edge of the Excel 
window across both monitors.  
 
To display two views of the same workbook in Excel 2007 or 2010, select New Window 
from the View menu, then select Arrange All, Tiled, OK also from the View menu. In Excel 
2003, select New Window from the Window menu, then select Arrange, Tiled, OK also 
from the Window menu. You can view multiple worksheets from the same workbook side-
by-side on a single monitor. In this situation, each window will scroll independently and best 
of all, according to reader Rick McNeil, updates entered into one window will automatically 
update the other windows. An example of multiple windows for the same workbook is 
shown below. 
 

 
 

Hint: To ignore other workbooks you have open, and arrange the windows for your current 
workbook only, check the Windows of active workbook checkbox in the Arrange Windows 
dialog box in Excel 2010, or the Arrange All dialog box in Excel 2007. 
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Pasting Away Again… 
 

Q. Often in Excel, I need to copy and paste the account number from one cell location to multiple 
cell locations. However, as soon as I use the Excel menu, the account number data from the source 
cell is deselected, and I must keep going back to recopy the original cell. Is there a trick to pasting 
contents to multiple cells without having to copy it repeatedly? 

 
A. This solution should help. Before you copy the contents of the source cell, click the F2 key to 
enter edit mode. Use your mouse to select the entire contents of the cell, then Right Mouse Click 
and select Copy from the popup menu (or press Ctrl + C). This action will copy the contents of your 
source cell to the Windows Clipboard where it will remain until you copy something else to 
clipboard. This will allow you to continue to paste the contents of the original cell multiple times 
without losing the source data, even if you use the Excel menu.       

 

 
 

Add Value, Instantly 
Opening two Workbooks in one Instance of Excel across Multiple Monitors 
 
Q. When I open Excel on my two separate monitors, Excel doesn’t allow me to use Paste 
Special, Value, Add; it only works when I have the two workbooks opened on the same 
monitor. What’s going on and how do I fix this? 
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A. The issue is not that you are using two computer monitors, the issue is that you have two 
instances of Excel open at the same time, and Excel’s paste function behaves differently 
when pasting between two instances of Excel compared to pasting between two workbooks 
opened in the same instance of Excel.  
 
Last month’s topic titled “An Excellent Arrangement” provided instructions for displaying 
two views of a single Excel workbook side-by-side on a single monitor. Building on this 
foundation, presented below are similar steps for displaying two different Excel workbooks 
side-by-side in a single instance of Excel stretched acorss two monitors. This approach will 
enable you to both view and use Paste Special, Value, Add between two different 
workbooks displayed on separate monitors.  
 

1. Open only one instance of Excel. 
2. Restore down the Excel window by double-clicking the Title Bar located at the top of the 

window.  
3. Stretch the window across both monitors by hovering your mouse pointer over either the 

left or right edge of the window until your pointer becomes a double arrow, then click and 
drag the window across both monitors.  

4. Open two Excel workbooks. 
5. In Excel 2007 and 2010, select Arrange All from the View tab to display the two workbooks 

side-by-side, each appearing in a sepeate monitor. In Excel 2003, select Arrange from the 
Window menu, select Tiled, and click OK. 

 
You can now use Paste Special, Value, Add between the two Excel workbooks.  
 

Foot Your Financials in Excel 
Attaching Footnotes to Excel-based Financial Statements 
 
Q. We produce financial statements from Excel, but typing the footnotes at the bottom of 
the financial statements is a headache because Excel does not offer word wrap, outlining 
and other word processing features. We have tried using different solutions such as Excel’s 
Justify command, and pasting from Word, but these solutions fall short, especially when 
edits are needed. Is there a better approach? 
 
A. Embedding a Word document in Excel as an object is a solution that provides Word 
processing functionality in Excel. To embed a Word document in an Excel 2003, 2007 or 
2010 worksheet, select Object from the Insert tab or menu, then select Microsoft Word 
Document and click OK. Use the mouse to reposition and resize the resulting embedded 
Word Document Object underneath the financial statement (or in the appropriate position) 
as pictured below.   
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The embedded Word object allows you to type using the same word processing 
functionality provided by Word, such as outlining, paragraph justification, indenting, and 
Word shortcuts (such as Shift+F3 to change case). When you click away from the Word 
object, the Word menus disappear and the Excel menus return to normal. Double clicking 
on the Word object reactivates the embedded object allowing you to further edit its’ 
contents using word processing functionality. 

 
 
To finalize your footnotes, consider adding the following finishing touches: 
 

1. Font - For consistency, change the footnote font to match the font used in the financial 
statements.  
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2. Border - Click away from the Word box to deactivate the object, and click the Word box 
once to select it. Right-mouse click on the edge of the Word object to display the popup 
menu, and select Format Object as pictured above. On the Colors and Lines tab, click the 
Line Color drop down arrow and select No Line, and click OK.  

 
Once printed, the resulting footnotes will appear seamlessly at the bottom of the financial 
reports, as shown below. 

 

A Colorful Preview  
Make Print Preview Display Charts and Tables in Color 

 
Q. I developed a presentation consisting of numerous Excel charts and data tables on my 
desktop computer, and I plan to use Print Preview to deliver the presentation. In practice, 
on my desktop computer this approach works well; but when I transfer the presentation to 
my laptop, the presentation previews in black and white, not color. I can’t find a setting 
anywhere to make my laptop preview in color. Can you help?  
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A. I applaud your ingenuity; using Print Preview can sometimes be a quick and easy method 
for organizing and displaying selected portions of your Excel worksheet to an audience. 
Excel’s Print Preview uses the system’s default printer as a basis for rendering the preview. 
If you change your computer’s default printer to a color printer, the previewed print job will 
display in color.  
 
To change your default printer setting, launch Control Panel from the Start button, and: 
 

1. In Windows 7, select Hardware and Sound, Devices and Printers, 
2. In Windows Vista, select Hardware and Sound, Printers, 
3. In Windows XP, select Printers and Faxes, 

 

Right click on a color printer, and select Set as default printer from the popup menu as 
pictured below. 

 
You can set up and use a color printer for Print Preview purposes, even if you do not have a 
color printer attached to your laptop computer. To add a color printer:  
 

1. Launch Control Panel and: 

 
a. In Windows 7 and Vista, select Hardware and Sound, Add a printer, 
b. In Windows XP, select Printers and Faxes, and under the Printer Tasks menu, select 

Add a printer, 
 

2. In the Add Printer dialog box, select Add a local printer,  
3. Choose any port from the Use an existing port drop down menu and click Next,  
4. Select any manufacturer and color printer model and click Next,  
5. Provide an appropriate name in the Printer Name box, click Next,  
6. If asked to share the printer, select No, 
7. Click Finish. 
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One Tall Solution 
Leave the Tall Print Setting Blank when Scaling to Width 
 
Q. When printing large worksheets in Excel 2003, is there an easy trick to figuring out how 
many pages tall the print job needs to be to ensure that my worksheet prints out as wide as 
possible on the page, but no wider? I usually set the page width to 1 page, then use the trial 
and error method to figure out how many pages tall the print job needs to be.  
 
A. Yes, there is an easy solution. Simply leave the tall box blank in Page Setup, and Excel will 
automatically calculate the number of pages tall the report needs to be to print your 
worksheet based on the number of pages wide you specify.  
 

 
 
Note: Excel 2007 and 2010 both provide the menu option Fit All Columns on One Page that 
accomplishes the same result.  
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I Hope to See You Zoom 
 

I use Excel 2003 and I sometimes find it difficult to read the small font in my 
worksheet. To make the worksheet more readable, I use the View, Zoom, 200% 
option, but I find it tedious to switch back and forth from 100% to 200% view. Is 

there a better approach that I am missing? 
 

In Microsoft Excel 2003, 2007 and 2010, you can zoom in and out instantly by 
holding down the Ctrl Key while rolling the wheel on your scrolling mouse. This 
approach is not only faster, but it also allows you to zoom up to a 400% view, down 

to a 10% view, and any option in between. This works in Microsoft Word too.  
 
Microsoft Office 2007 and 2010 now include a new Zoom tool at the bottom right hand 
corner of the screen which accomplishes the same result.  
 

 
 

It’s Time to Split 
 
Q. I have a large Excel worksheet and I need to be able to compare data throughout the 
worksheet. I’ve been using the View, Freeze Panes tool to temporarily freeze rows or 
columns so that I can view and compare data in different parts of the worksheet, but this 
method requires a lot of freezing and unfreezing. Is there a better option? 
 
A. Excel 2003, 2007 and 2010 contain two Split Screen tools which allow you to quickly split 
the Excel worksheet horizontally, vertically, or both. Like the Freeze Pane tool, the split 
screen tools also allow you to view and compare different portions of your data. To use 
these tools, click and drag the split screen tools to the desired positions. The Split Screen 
tools are located in the upper right hand corner and lower right hand corner of the 
worksheet area, as shown below. 
 

       
 

Q 

A 
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In the example below the Vertical Split Screen tool has been used to display data for the 1st 
quarters of 2009 and 2010. (Notice that the columns jump from column E to column O). 
Additionally, the Horizontal Split Screen tool has been used to fix the column headings at 
the top of the worksheet. (Notice that the row numbers jump from row 3 to row 7.)  

 

 
 

I Command You 
 
Q. Recently, I upgraded to Excel 2007 and I can’t seem to find all of the same commands I 
used in Excel 2003, such as the ability to e-mail a single worksheet or pivot multiple ranges 
of data. Why did Microsoft get rid of some of Excel 2003’s commands and are there any 
good work-around procedures for these missing capabilities? 
 
A. The missing functionality you mention is still there in Excel 2007 and 2010, but it is 
hidden. When Microsoft redesigned the menus for Excel 2007 and 2010, they excluded 219 
commands from the newer menu ribbon. To view a complete list of these hidden 
commands follow these steps: Start by right-mouse clicking on the Quick Access Toolbar 
and choosing the option to Customize Quick Access Toolbar.  
 

 
 
Next, in the Choose commands from drop down box, select the option to view Commands 
Not in the Ribbon.  
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This action will display the list of 219 commands not included in the ribbon on the left side 
of the dialog box, and those commands that are included in your Quick Access Toolbar on 
the right side of the dialog box.  
 

 
 
To access these hidden commands, you must first add them to your Quick Access Toolbar 
by highlighting the desired command in the left column, and clicking the Add>> button to 
include it in the right column. Most of the hidden tools are obscure and seldom used, 
however some of them are among my favorites. The seven Excel 2003 commands that are 
most notably missing from the Excel 2007 and 2010 menu ribbon are shown below. 
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While the particular commands you choose to add to your 
Quick Access Toolbar will depend on personal preference, I 
recommend that you add the above mentioned commands 
to your Quick Access Toolbar, as well as the following 
twenty additional commands (shown to the right) which I 
personally find more useful, to make them easily 
assessable. 
 

 
 
 
 
 
Note: There are a few Excel 2003 capabilities that have disappeared from Excel 2007 and 
2010. For example: 
 

1. You can no longer publish web pages in an interactive format (The interactive format 
command in Excel 2003 allows you to publish HTML pages in which readers can input 
data directly via their browser).  
 

2. Embedded video clips and sound clips no longer play as embedded objects in Excel 2007 
and 2010; instead those clips are played in your computer’s default media player 
application.  

 

3. There is no longer an auto format option which automatically highlights your subtotal 
rows.  

 
 

  

I price check almost everything I buy at Pricegrabber.com – which checks 
millions of products from hundreds of thousands of stores. I frequently save 
50% by buying refurbished computer gear, it’s still under full warranty.  
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Chapter 8 

XML Data 
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Overview of XML in Excel 
Microsoft Office Excel makes it easy to import Extensible Markup Language (XML) (Extensible 
Markup Language (XML): A condensed form of Standard Generalized Markup Language (SGML) that 
enables developers to create customized tags that offer flexibility in organizing and presenting 
information.) data that is created from other databases and applications, to map XML elements 
from an XML schema (XML Schema: A formal specification, written in XML, that defines the 
structure of an XML document, including element names and rich data types, which elements can 
appear in combination, and which attributes are available for each element.) to worksheet cells, and 
to export revised XML data for interaction with other databases and applications. Think of these 
XML features as turning Office Excel into an XML data file generator with a familiar user interface. 

 
1. Why use XML in Excel?  

a. XML data and schema files  
b. Key XML and Excel scenarios  

2. The basic process of using XML data in Excel  
a. Working with XML maps  
b. Using the XML Source task pane  
c. Element types and their icons  
d. Working with single-mapped cells  
e. Working with repeating cells in XML tables  
f. XML map security considerations  
g. Importing XML data  
h. Working with an inferred schema  
i. Exporting XML data  

3. Using the Excel macro-enabled Office XML Format file  

 

Why use XML in Excel? 
XML is a technology that is designed for managing and sharing structured data in a human-readable 
text file. XML follows industry-standard guidelines and can be processed by a variety of databases 
and applications. Using XML, application designers can create their own customized tags, data 
structures, and schemas. In short, XML greatly eases the definition, transmission, validation, and 
interpretation of data between databases, applications, and organizations. 
 

XML data and schema files 
Excel works primarily with two types of XML files: XML data files (.xml), which contain the custom 
tags and structured data. Schema files (.xsd), which contain schema tags that enforce rules, such as 

data type and validation.  Note   The XML standard also defines Extensible Stylesheet Language 

Transformation (XSLT) (XSL Transformation (XSLT): A file that is used to transform XML documents 
into other types of documents, such as HTML or XML. It is designed for use as part of XSL.) (.xslt) 
files, which are used to apply styles and transform XML data into different presentation formats. 
You can apply these transforms before you import XML files into Excel and after you export XML 
files from Excel. If XSLT files are linked to XML data files that you import into Excel, you do have the 
option to apply or not apply the formatting before the data is added to the worksheet, but only 
when you open an XML file by using the Open command on the Microsoft Office Button . 
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Key XML and Excel scenarios 
By using XML and Excel, you can manage workbooks and data in ways that were previously 
impossible or very difficult. By using XML maps, you can easily add, identify, and extract specific 
pieces of business data from Excel documents. For example, an invoice that contains the name and 
address of a customer or a report that contains last quarter's financial results are no longer just 
static reports. You can easily import this information from databases and applications, revise it, and 
export it to the same or other databases and applications. The following are key scenarios that the 
XML features are designed to address: 
 

1. Extend the functionality of existing Excel templates by mapping XML elements onto existing 
cells. This makes it easier to get XML data into and out of your templates without having to 
redesign them.  

2. Use XML data as input to your existing calculation models by mapping XML elements onto 
existing worksheets.  

3. Import XML data files into a new workbook.  

4. Import XML data from a Web service into your Excel worksheet.  

5. Export data in mapped cells to XML data files independent from other data in the workbook.  
 

The basic process of using XML data in Excel 
The following diagram shows how the different files and operations work together when you use 
XML with Excel. Essentially, there are five phases to the process: 

 

 
1. Adding an XML schema file (.xsd) to a workbook  

2. Mapping XML schema elements to individual cells or XML tables  

3. Importing an XML data file (.xml) and binding the XML elements to mapped cells  

4. Entering data, moving mapped cells, and leveraging Excel functionality, while preserving 
XML structure and definitions  

5. Exporting revised data from mapped cells to an XML data file  

6.  
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Working with XML maps 
You can create or open a workbook in Excel, attach an XML schema file (.xsd) to the workbook, and 
then use the XML Source task pane to map XML elements of the schema to individual cells or tables. 
After you map the XML elements to your worksheet, you can import and export XML data into and 
out of the mapped cells. When you add an XML schema file (.xsd) to your workbook, you create an 
XML map. In general, XML maps are used to create mapped cells and to manage the relationship 
between mapped cells and individual elements in the XML schema. In addition, these XML maps are 
used to bind the contents of mapped cells to elements in the schema when you import or export 
XML data files (.xml). 
 
There are two kinds of mapped cells that you can create: single-mapped cells and repeating cells 
(which appear as XML tables). To make designing your worksheet more flexible, you can drag the 
mapped cells anywhere on a worksheet and into any order — even one different from the XML 
schema. You can also choose which elements to map and not map. 

 
The following rules about using XML maps are important to know: 

1. A workbook can contain one or more XML maps.  

2. You can only map one element to one location in a workbook at a time.  

3. Each XML map is an independent entity, even if multiple XML maps in the same workbook 
refer to the same schema.  

4. An XML map can only contain one root element. If you add a schema that defines more than 
one root element, you are prompted to choose the root element to use for the new XML 
map.  

 

Using the XML Source task pane 
You use the XML Source task pane to manage XML maps. To open it, on the Developer tab, in the 
XML group, click Source. The following diagram shows the main features of this task pane. 
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1. Lists XML maps that were added to the workbook 

2. Displays a hierarchical list of XML elements in the currently listed XML map 

3. Sets options when working with the XML Source task pane and the XML data, such as how 
to preview the data and control headings 

4. Opens the XML Maps dialog box, which you can use to add, delete, or rename XML maps 

5. Verifies whether you can export XML data through the current XML map 

 
 

Element types and their icons 
The following table summarizes each type of XML element that Excel can work with and the icon 
that is used to represent each type of element. 
 

Element type Icon 

Parent element   

Required parent element   

Repeating parent element  

Required repeating parent element   

Child element   

Required child element  

Repeating child element  

Required repeating child element  

Attribute  

Required attribute  

Simple content in a complex structure  

Required simple content in a complex structure  
 
Working with single-mapped cells 
A single-mapped cell is a cell that has been mapped to a nonrepeating XML element. You create a 
single-mapped cell by dragging a nonrepeating XML element from the XML Source task pane onto a 
single cell in your worksheet. When you drag a nonrepeating XML element onto the worksheet, you 
can use a smart tag to choose to include the XML element name as a heading above or just to the 
left of the single-mapped cell, or you can use an existing cell value as a heading. You can also use a 
formula in a single-mapped cell, if the cell is mapped to an XML element with an XML Schema 
Definition (XSD) data type that Excel interprets as a number, date, or time. 
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Working with repeating cells in XML tables 
XML tables are similar in appearance and functionality to Excel tables. An XML table is an Excel table 
that has been mapped to one or more XML repeating elements. Each column in the XML table 
represents an XML element. An XML table is created when you: 
 

1. Use the Import command (in the XML group on the Developer tab) to import an XML data 
file.  

2. Use the Open command (on the Microsoft Office Button ) to open an XML data file — and 
then select As an XML table in the Open XML dialog box.  

3. Use the From XML Data Import command (from the From Other Sources command button, 
in the Get External Data group, on the Data tab) to import an XML data file — and then 
select XML table in existing worksheet or New worksheet in the Import Data dialog box.  

4. Drag one or more repeating elements from the XML Source task pane to a worksheet.  

5. When you create an XML table, the XML element names are automatically used as column 
headings. You can change these to any column headings that you want. However, the 
original XML element names are always used when you export data from the mapped cells. 

 
Two options under the Options button in the XML Source task pane are useful when you work with 
XML tables: 

1. Automatically Merge Elements When Mapping  When selected, Excel creates one XML 
table from multiple fields as they are dropped onto the worksheet. This option works as long 
as the multiple fields are dropped on the same row, one adjacent to the other. When this 
option is cleared, each element appears as its own XML table.  

2. My Data Has Headings  When selected, existing heading data is used as column headings for 
repeating elements that you map to your worksheet. When this option is cleared, the XML 
element names are used as column headings.  

 
Using XML tables, you can easily import, export, sort, filter, and print data based on an XML data 
source. However, XML tables do have some limitations regarding how they can be arranged on the 
worksheet. 

 XML tables are row-based, meaning that they grow from the header row down. You cannot add new 
entries above existing rows. You cannot transpose an XML table so that new entries will be added to 
the right. You can use formulas in columns that are mapped to XML elements with an XML Schema 
Definition (XSD) data type that Excel interprets as a number, date, or time. Just as in an Excel table, 
formulas in an XML table are filled down the column when new rows are added to the table. 
 
XML map security considerations 
An XML map and its data source information are saved with the Excel workbook, not a specific 
worksheet. A malicious user can view this map information by using a Microsoft Visual Basic for 
Applications (VBA) macro. Furthermore, if you save your workbook as a macro-enabled Excel Open 
XML Format File, this map information can be viewed through Microsoft Notepad or through 
another text-editing program. 
 
If you want to keep using the map information but remove the potentially sensitive data source 
information, you can delete the data source definition of the XML schema from the workbook, but 
still export the XML data, by clearing the Save data source definition in workbook check box in the 
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XML Map Properties dialog box, which is available from the Map Properties command in the XML 
group on the Developer tab. 
 
If you delete a worksheet before you delete a map, the map information about the data sources, 
and possibly other sensitive information, is still saved in the workbook. If you are updating the 
workbook to remove sensitive information, make sure that you delete the XML map before you 
delete the worksheet, so that the map information is permanently removed from the workbook. 
 
Importing XML data 
You can import XML data into an existing XML map in your workbook. When you import data, you 
bind the data from the file to an XML map that is stored in your workbook. This means that each 
data element in the XML data file has a corresponding element, in the XML schema, that you 
mapped from an XML Schema file or inferred schema. Each XML map can only have one XML data 
binding, and an XML data binding is bound to all of the mappings that were created from a single 
XML map. You can display the XML Map Properties dialog box (Click Map Properties in the XML 
group on the Developer tab.), which has three options, all selected by default, that you can set or 
clear to control the behavior of an XML data binding: 
 

1. Validate data against schema for import and export  Specifies whether Excel validates data 
against the XML map when importing data. Click this option when you want to ensure that 
the XML data that you import conforms to the XML schema.  

2. Overwrite existing data with new data  Specifies whether data is overwritten when you 
import data. Click this option when you want to replace the current data with new data, for 
example, when up-to-date data is contained in the new XML data file.  

3. Append new data to existing XML tables  Specifies whether the contents of the data source 
are appended to the existing data on the worksheet. Click this option, for example, when 
you are consolidating data from several similar XML data files into an XML table, or you do 
not want to overwrite the contents of a cell that contains a function.  

 
When you import XML data, you may want to overwrite some mapped cells but not others. For 
example, some mapped cells may contain formulas and you don't want to overwrite the formula 
when you import an XML file. There are two approaches that you can take: 
 

1. Unmap the elements that you don't want overwritten, before you import the XML data. 
After you import the XML data, you can remap the XML element to the cells containing the 
formulas, so that you can export the results of the formulas to the XML data file.  

2. Create two XML maps from the same XML schema. Use one XML map for importing the XML 
data. In this "Import" XML map, don't map elements to the cells that contain formulas or 
other data that you don't want overwritten. Use another XML map for exporting the data. In 
this "Export" XML map, map the elements that you want to export to an XML file.  

 
The ability to import XML data from a Web service by using a Data Retrieval Service Connection 
(.uxdc) file to connect to a data source is no longer supported in Microsoft Office Excel 2007 through 
the user interface. If you open a workbook that was created in Office Excel 2003, you can still view 
the data, but you cannot edit or refresh the source data. 
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Working with an inferred schema 
If you import XML data without first adding a corresponding XML schema to create an XML map, 
Excel tries to infer a schema for you based on the tags that are defined in the XML data file. The 
inferred schema is stored with the workbook, and the inferred schema allows you to work with XML 
data if an XML schema file isn't associated with the workbook. When you work with imported XML 
data that has an inferred schema, you can also customize the XML Source task pane. Select the 
Preview Data in Task Pane option from the Options button to display the first row of data as sample 
data in the element list, if you imported XML data associated with the XML map in the current 
session of Excel. 
 
You cannot export the Excel inferred schema as a separate XML schema data file (.xsd). Although 
there are XML schema editors and other methods for creating an XML schema file, you may not 
have convenient access to them or know how to use them. As an alternative, you can use the Excel 
2003 XML Tools Add-in Version 1.1, which can create a schema file from an XML map. For more 
information, see Using the Excel 2003 XML Tools Add-in Version 1.1. 
 
Exporting XML data 
You export XML data by exporting the contents of mapped cells on the worksheet. When you export 
data, Excel applies the following rules to determine what data to save and how to save it: 
 

1. Empty items are not created when blank cells exist for an optional element, but empty items 
are created when blank cells exist for a required element.  

2. Unicode Transformation Format-8 (UTF-8) encoding is used to write the data.  

3. All namespaces are defined in the Root XML element.  

4. Excel overwrites existing namespace prefixes. The default namespace is assigned a prefix of 
ns0. Successive namespaces are designated ns1, ns2 to ns<count> where <count> is the 
number of namespaces written to the XML file.  

5. Comment nodes are not preserved.  

6. You can display the XML Map Properties dialog box (Click Map Properties in the XML group 
on the Developer tab.) and then use the Validate data against schema for import and 
export option (active by default) to specify whether Excel validates data against the XML 
map when exporting data. Click this option when you want to ensure that the XML data you 
export conforms to the XML schema. 

 
Using the Excel Macro-enabled Office XML Format File 
You can save an Excel workbook in a variety of file formats, including the Excel macro-enabled Office 
XML Format File (.xlsm). Excel has a defined XML schema that defines the contents of an Excel 
workbook, including XML tags that store all workbook information, such as data and properties, and 
define the overall structure of the workbook. Custom applications can use this Excel macro-enabled 
Office XML Format File. For example, developers may want to create a custom application to search 
for data in multiple workbooks that are saved in the this format and create a reporting system based 
on the data found. 

 
  

http://office.microsoft.com/search/redir.aspx?AssetID=XT011894931033&CTT=5&Origin=HA102063961033
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Chapter 9 
 

What’s New in 
Microsoft Excel 2010 
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What’s New in Microsoft Office 2010? 

Microsoft has announced that it will begin shipping Office 2010 in Spring 2010. This begs the 
question, what’s new in Office 2010? The short answer is that there are a dozen or so 
interesting improvements each in Word, Excel, PowerPoint, and Access - but for the most 
part Office’s core products are unchanged. This is because when Office 2007 was released in 
January 2007, the new menus only appeared in 4.5 of the applications – Word, Excel, 
Access, PowerPoint and half of Outlook. With Office 2010, Microsoft has brought the other 
applications up-to-date with the newer menu style as well. Therefore don’t expect to see 
many differences in Word, Excel, Access, or PowerPoint. However, these are a few 
improvements Office 2010’s core products, as follows: 

What’s New in Excel 2010? 

1. Sparklines – Sparklines are small cell-sized charts that you can embed in a worksheet 
next to data to get a quick visual representation of the data. For example, if you had 
a worksheet that tracked the performance of several dozen stocks, you could create 
a Sparkline for each stock that graphed its performance over time, in a very compact 
way. Here is an example: 

 

 

2. Conditional Formatting Improvements – Microsoft has improved and added more 
styles and icons regarding the ability to apply a format to a range of cells, and then 
have the formatting change according to the value of the cell or formula. 

 
3. Improved Sharing – As with all of the Office 2010 applications, Excel 2010 has new 

and improved tools for sharing data with other people, including multiple people 
working on a document at a time.  

 
4. Millions of Rows - Microsoft now offers Project Gemini add-on for Excel 2010 that 

can handle very large amounts of data -- even worksheets that include hundreds of 
millions of rows. It will ship as part of SQL Server 2008 R2 in the first half of 2010; a 
community technology preview will be available in the second half of 2009. 

 
5. Enhanced Ribbon Toolbar - The Ribbon tool bar has been enhanced to be highly 

customizable now. 

 

http://www.addictivetips.com/wp-content/uploads/2009/09/Sparklines.png
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6. Compatibility of .xlsx - In Excel 2007, Microsoft introduced a new XML format (.xlsx) which 
was not compatible with former .xls spreadsheet formats. This problem has been resolved - 
Excel files created in Excel 2010 may easily be opened in versions of Excel prior to Excel 
2007. Now Excel 2010 will save files just as safe as the former Excel 2007, and the 
spreadsheet size is 75% smaller than the old .XLS version. 

 

 
 

7. Protected Mode - Each time you download a document , Microsoft Office 2010 
automatically opens it in Protected Mode which means that Excel will not allow you to edit 
the documents unless document editing is enabled. To do this, click the Enable Editing 
option in order to enable document editing as shown in the following  screen shot. 

 

  

http://www.addictivetips.com/wp-content/uploads/2009/09/ExcelRibbon.png
http://www.addictivetips.com/wp-content/uploads/2009/09/protectedmode11.png
http://www.addictivetips.com/wp-content/uploads/2009/09/ExcelRibbon.png
http://www.addictivetips.com/wp-content/uploads/2009/09/protectedmode11.png
http://www.addictivetips.com/wp-content/uploads/2009/09/ExcelRibbon.png
http://www.addictivetips.com/wp-content/uploads/2009/09/protectedmode11.png
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8. Slicer - The Slicer feature provides new slice and dice capabilities within PivotTables – this 
helps you dynamically segment and filter the data. This feature is located on the Insert Tab. 

 

9. Macro - Macros in Excel 2010 now support working with shapes, including creating, moving 
or editing shapes. 
 

10. Enhanced Chart Diagram - In Excel 2010 double clicking a chart element automatically 
opens the chart’s format dialog box. 
 

11. Web Version of Excel 2010 – A new web version of Excel 2010 allows you to create, edit and 
save spreadsheet via your web browser directly and share them online. The web version 
reportedly will be available for free to everyone who has Windows Live account. The web 
version is as same as the Excel 2010 on desktop, with some of Excel functionality disabled. 
 

12. 64-bit version of Excel 2010 - Excel 2010 is now available in a 64-bit version, which means 
that it can take full advantage of your computer’s 64-bit motherboard and access more than 
4 GBs of RAM. The result is even faster performance. 
 

13. Microsoft SQL Server PowerPivot for Excel - Excel 2010 now includes an add-in tool called 
Microsoft SQL Server PowerPivot which is a Business Intelligence tool that enables you to 
query multiple SQL Server databases across multiple corporate systems and web data on a 
real-time basis to produce PivotTables that can be shared via SharePoint. You can try this 
online at the following Virtual Labs web site: 
 

https://cmg.vlabcenter.com/prepare.aspx?moduleid=ad3bd3e9-8d2b-498d-94fa-
e41e1b09730d&ticks=633992819904236083.  
 

14. Named Sets - Named Sets have been added to Microsoft Excel 2010, allows you to create 
your own named sets. Simply locate the  Fields, Items, & Sets button under the Ribbon, and 
it will allow you to define your own Named Sets. 

  

https://cmg.vlabcenter.com/prepare.aspx?moduleid=ad3bd3e9-8d2b-498d-94fa-e41e1b09730d&ticks=633992819904236083
https://cmg.vlabcenter.com/prepare.aspx?moduleid=ad3bd3e9-8d2b-498d-94fa-e41e1b09730d&ticks=633992819904236083
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Bio for J. Carlton Collins, CPA 
ASA Research   Carlton@ASAResearch.com   770.842.5902 

 

J. Carlton Collins, CPA is a Certified Public Accountant with experience in technology, 
tax, auditing, accounting systems, financial reporting, and bond financing. He is an 
author, lecturer, and technology & accounting systems consultant. He has published 
books, articles, and web pages and is the author of the monthly technology Q&A 
column for the Journal of Accountancy. As a public speaker, Mr. Collins has delivered 
more than 2,000 lectures in 44 states and 5 countries addressing more than 500,000 
CPAs and business professionals. As a consultant, Mr. Collins has assisted 275+ large 

and small companies with the selection and implementation of accounting systems. Mr. Collins has a Bachelor’s 
degree in Accounting from the University of Georgia, is a 25+ year member of the American Institute of CPAs and 
the Georgia Society of CPAs, and is also a licensed realtor. 
  
Summary of Selected Positions, Awards & Accomplishments:  
  

1.   Honored as one of the CPA Industries Top 25 Thought Leaders by CPA Technology Advisor Magazine 

2.   Author of the monthly Technology Q&A column for the Journal of Accountancy. 
3.   Recipient of the AICPA’s Lifetime Technical Contribution to the CPA Profession Award.  
4.   Chairman of the Southeast Accounting Show - the South’s largest CPA event. 
5.   Recipient of the Tom Radcliff Outstanding Discussion Leader Award.  
6.   Named “Top Ten CPA Technologists” by Accounting Technologies Magazine (multiple years). 
7.   Named “Top 100 Most Influential CPAs ” by Accounting Technologies Magazine (multiple years). 
8.   Has personally delivered over 2,000 technology lectures around the world. 
9.   Recipient of the Outstanding Discussion Leader Award from the Georgia Society of CPAs.  
10. Lead author for PPC's Guide to Installing Microcomputer Accounting Systems.   
11. Has installed accounting systems for more than 200 companies. 
12. Chairperson of the AICPA Technology Conference.  
13. Recipient of the ACCPAC Partner of the Year Award. 
14. Determined by SAP to be one of the country's "Top Ten Most Influential ERP Systems Consultants". 
15. Has delivered keynote and session lectures at dozens of accounting software conferences. 
16. Sworn in as a Certified Public Accountant on September 18, 1985. 
17. Member of the American Institute of CPAs since 1985. 
18. Member of the Georgia Society of CPAs since 1982. 

  
 As an auditor, Mr. Collins has audited businesses in the areas of health care, construction, distribution, automobile 
dealerships, insurance, manufacturing, and general business.  Mr. Collins' tax experience includes corporate, 
individual, partnership, fiduciary, and estate tax planning work.  In the area of finance, Mr. Collins has prepared (or 
assisted in preparing) feasibility studies and financial forecasts for nearly 300 projects seeking more than $3 billion 
in startup capital. Mr. Collins is familiar with bond issues, Medicare and Medicaid reimbursement, and 
conventional financing matters. In 1992, Mr. Collins contributed and demonstrated more than 500 pages of 
suggested design improvements to the Microsoft Excel development team of programmers - and many of those 
improvements are found in Excel today. 
 
At the University of Georgia, Mr. Collins was elected President of the Phi Eta Sigma Honor Society, was initiated 
into the BIFTAD Honor Society, served three years in the Judicial Defender/Advocate program, and was a member 
of Alpha Tau Omega fraternity. At Glynn Academy High School, Mr. Collins was Senior Class President, Class 
Valedictorian (1 of 6), and received a principle nomination to Annapolis Naval Academy. Mr. Collins has been 
married for 27 years and has two children. He devotes his leisure time to family, travel, tennis, fishing, snow skiing, 
and riding motorcycles (both dirt and street). Mr. Collins is president of his homeowners association, participates 
in the Gwinnett Clean and Beautiful program, and volunteers for Cooperative Ministries food drive. 
  

mailto:Carlton@ASAResearch.com
http://www.journalofaccountancy.com/
http://www.cpatechnologyadvisor.com/web/online/NEWS/The-CPA-Technology-Advisors-Top-25-Thought-Leader-Symposium-Honors-Achievement/1$3210
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Because I had an extra page left in this book, I’ll throw in a few jokes and quotes to brighten 
your day. Enjoy! 
 
 I’m so poor I can’t even pay attention 

 I have enough money to last me the rest of my life...unless I buy something. 

 It's so simple to be wise. Just think of something stupid to say and then don't say it! 

 I'm searching for fun and happiness that does not involve food or money... 

 We make a living by what we get, we make a life by what we give. 

 Count your age with friends but not with years. 

 Never play leapfrog with a unicorn. 

 Friction can be a drag. 

 When I want your opinion, I'll remove the duct tape. 

 Light travels faster than sound. That's why some people appear bright until you hear them speak. 

 Football is a combination of two of America’s worst elements: Violence and committee meetings. 

 I haven't spoken to my wife in years; I don't like to interrupt her. 

 My fake plants died because I did not pretend to water them 

 Never let a computer know you're in a hurry. 

 I totally take back all those times I didn't want to nap when I was younger. 

 I planned to surprise my wife with a new centerpiece for the table...but the taxidermist was closed. 

 I have kleptomania, but when it gets bad, I take something for it. 

 For every action, there is an equal and opposite government program.  

 Even free advice costs more than it used to. 

 Love is holding hands in the street. Marriage is holding arguments in the street. 

 I always try to hold hands with my wife...because if I let go she'll start shopping! 

 My back goes out more than I do. 

 An Adult is a person who has stopped growing at both ends and is now growing in the middle. 

 The journey of a thousand miles ... begins with a broken fan belt. 

 I'm getting serious about exercising - I've moved my TV set much farther away from my refrigerator. 

 A Freudian slip is when you say one thing but mean your mother. 

 While in the army, Will never liked the phrase "Fire at will". 

 Studies have shown that you can live longer by having more birthdays. 

 My wife keeps saying that I don’t listen to her...or something like that. 

 My life goal is to be filthy stinking rich...well, 2 out of 3 ain't bad. 

 A child of five would understand this. Send someone to fetch a child of five. 

 Warning: Dates in Calendar are closer than they appear. 

 Because of these hard economic times, I have started selling furniture on the side. The trouble is, it 
is my own. 

 
 

Carlton’s CPE Prayer 
Now I lay me back to sleep. 

The speaker's dull; the subject's deep. 
If he should stop before I wake, 

Give me a nudge for goodness' sake. 


